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はじめに
光を扱うことがすべてのはじまりです。

Unity は HD レンダーパイプライン（HDRP）を開発しましたが、これはクリエイター
がハイエンド PC やゲーム機などの性能を発揮し、新境地となるリアリティあふれる
グラフィックスを生み出してクリエイターの描く構想を具現化する、ということを目
的としたものでした。

このガイドでは、Unity をご利用のアーティストやクリエイターの方向けに、HDRP 
の物理ベースでのライティングの手法を紹介いたします。HDRP は Unity のリアルタ
イムレンダリングの技術的な進歩を象徴するものであり、現実世界と同じようなライ
ティングを実現することができます。

みずみずしく生い茂る熱帯雨林の風景に自然な太陽光を当ててレンダリングしたり、
かと思えば都会のコンクリートジャングルではネオンのエミッシブライティングをふ
んだんに使って雰囲気を出したり…きっとあなたの作りたい雰囲気に合ったものもあ
るでしょう。HDRP なら、映画の撮影監督のようにシーンを彩ることが可能です。

見慣れた場所から幻想的な世界へプレイヤーを連れていけるようなゲーム環境を構築
できます。

さあ、HDRP と Unity を使ってみましょう！

Book of the Dead では、HDRP を使用して雰囲気のあるライティングを作成しています。

https://unity.com/ja/
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HDRP ライティングの 
概要
HDRP は、多様な機能で Unity の既存のライティングシステムを拡張
し、あなたの作るシーンのレンダリングをより現実世界のライティン
グに近いものにしてくれます。

— 物理ベースのライト単位と露出：HDRP では、現実世界の光の強度と単位を使
用します。8既知の光源の基準に合わせて、物理カメラを使用して露出を設定
します。

— 高度なライティング：スポットライトやエリアライト用の新しい形状オプショ
ンを使用して、ライトの配置を制御します。ライトレイヤーを使用して、特定
のメッシュへのライトの影響を制限します。スクリーンスペースグローバルイ
ルミネーションや Screen Space Refraction などのリアルタイムエフェクトを
適用できます。

— 空の景色：多彩な技術で自然な空を創造することができます。Physically 
Based Sky システムを使用して、惑星の大気のシミュレーションを手続き型で
行ったり、ボリュメトリッククラウドやクラウドレイヤーを追加したり、HDRI 
を適用して静的な空のシミュレーションを行ったりできます。

— フォグ：フォグを使用して、シーンに奥行きや立体感を加えます。ボリュメト
リックを有効にして、フォグエフェクトをフォアグラウンドオブジェクトに組
み込むことで、シネマティックな光の軌跡をレンダリングできます。ボリュメ
トリックライトやシャドウをライトごとに管理して、ローカルボリュメトリッ
クフォグコンポーネントを使用し、3D マスクテクスチャーでフォグの密度を
微細に調整することが可能です。

— ボリュームシステム：HDRP には直観的なシステムが採用されており、カメラ
の位置や優先度に応じて、さまざまなライティングエフェクトや設定を遮断で
きます。ボリュームを重ねたりブレンドしたりすることで、シーン内のあらゆ
る領域を非常に細かく制御できます。

— ポストプロセッシング：HDRP のポストプロセッシングは、既存のボリューム
システムからうまく処理を行い、Volume オーバーライドにてまとめて管理さ
れています。アンチエイリアシング、トーンマッピング、カラーグレーディング、
被写界深度、その他のさまざまなエフェクトを追加できます。

— 高度なシャドウ：HDRP では、ビジュアルの美しさとパフォーマンスの兼ね合
いを考慮しつつもシャドウを制御することができる高度な機能を使用すること
ができます。色合いやフィルタリング、解像度、メモリバジェット、更新モー
ドを調整できます。コンタクトシャドウや微細なシャドウを利用して、細かい
ディテールやさらなる深みを際立たせましょう。

— 高度なリフレクション：さまざまな手法を使用して反射面をレンダリングでき
ます。リフレクションプローブでは、従来からあるリフレクションマッピング
手法に加え、フラットな表面向けのより高度なオプションが用意された平面リ
フレクションプローブを使用できます。さらにスクリーンスペースリフレク
ション（SSR）によって、深度バッファーを使用したリアルタイム手法を利用
できます。

https://unity.com/ja/
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拡張性：HDRP は Unity のスクリプタブルレンダーパイプラインを基盤にしていま
す。経験豊富なテクニカルアーティストやグラフィックスプログラマーであれば、
パイプラインを標準機能以外にも拡張できます。
 
HDRP に触れるのがまったく初めてという方は、「Up and Running with HDRP」を
ご覧ください。

インストール
Unity 2021 LTS 以降では、常に検証済みの最新のグラフィックスコードを利用し
ていただけるよう、インストールファイルに HDRP パッケージが含まれています。
Unity の最新リリースをインストールすると、それに対応するバージョンの HDRP も
インストールされます。

HDRP グラフィックスパッケージを Unity の特定のリリースに関連付けることで、互
換性を確保しやすくなります。ただし、マニフェストファイルをオーバーライドする
ことで、HDRP のカスタムバージョンに切り替えることもできます。

システム要件

現在、HRDP に対応するターゲットプラットフォームは次のとおりです。

— DirectX 11 または DirectX 12 と Shader Model 5.0 対応の Windows および 
Windows ストア

— 最新のコンソール（Sony PlayStation 4 または Microsoft Xbox One 以上）

— Metal グラフィックス対応の MacOS（バージョン 10.13 以降）

— Vulkan 対応の Linux および Windows プラットフォーム

HDRP は、コンピュートシェーダー対応のコンソールおよびデスクトッププラット
フォームでのみ機能します。HDRP は、OpenGL または OpenGL ES デバイスには
対応していません。詳しくは、要件と互換性に関するドキュメントをご覧ください。

対応している VR プラットフォームおよびデバイスについては、「HD レンダーパイ
プラインの VR」をご覧ください。

HDRP のパッケージバージョン 互換性のある Unity バージョン

13.x 2022.1

12.x 2021 LTS（このガイドで使用）

https://unity.com/ja/
https://docs.unity3d.com/Manual/ScriptableRenderPipeline.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://learn.unity.com/project/up-and-running-with-hdrp?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Manual/upm-manifestPrj.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/System-Requirements.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/VR-Overview.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/VR-Overview.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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Unity Hub
 
Unity Hub を使用するのが、最も簡単に HDRP プロジェクトを設定する方法です。

まず、新しいプロジェクトを作成します。選択できるテンプレートの中から「3D 
(HDRP)」という空のテンプレートまたは「3D Sample Scene (HDRP)」を選択しま
す（旧バージョンの Hub での呼称は「High Definition RP」です）。最新のものを選
択して、サンプルのプリセットを含む HDRP パッケージをインポートしてください。

「Sample Scene」をロードします。次のようなシーンが表示されます。

「3D Sample Scene (HDRP)」テンプレートを選択します。

「3D Sample Scene」のプロジェクト設定

https://unity.com/ja/
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 1  Unity 2021.2/HDRP 12 では、「Window > Rendering > HDRP Wizard」にあります。

Package Manager のインストール

「3D Core template」を使用してプロジェクトを作成した場合は、以前までのビル
トインレンダーパイプラインが使用されることになります。パッケージマネージャー
（「Window > Package Manager」）からであれば HDRP に手動でプロジェクトを移
行することができます。

Unity Registry で「High Definition RP」パッケージを確認（または検索フィールド
を使用して確認）し、インストールします。

 
現行のプロジェクト設定で競合が発生した場合には、トラブルシューティングに対応
した「HDRP Render Pipeline Wizard」が表示されます（「Window > Rendering > 
HDRP Wizard」で開くこともできます）。1

「Configuration Checking」で「Fix All」をクリックするか、「Fix」をクリックして
それぞれの問題を個別に修正します。このチェックリストは、非 SRP プロジェクト
からの移行時にも役立ちます。

Package Manager のインストール

https://unity.com/ja/
https://docs.unity3d.com/Manual/built-in-render-pipeline.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Manual/built-in-render-pipeline.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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ウィザードでの操作が完了すると、新規 HDRP パイプラインアセットの作成を促す
プロンプトが表示されます。対象のファイルはディスク上の、設定したこの特定のパ
イプライン設定を保存するためのものになります。「Create One」を選択して、新し
いレンダーパイプラインアセットを追加し、ファイルを割り当てます。

HDRP が適切に機能するようになると、「Configuration Checking」内のチェックボッ
クスがすべて緑色になり、背景環境の色調がはっきりと変わります。

なお、空白のプロジェクトを使って手動でインストールを行った場合は、「3D 
Sample Scene (HDRP)」がインポートされません。このガイドに出てくるサンプ
ルアセットを使用したい場合は、「3D Sample Scene」テンプレートを使用してく
ださい。

HDRP ウィザード

https://unity.com/ja/
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HDRP のサンプルシーン
Unity Hub から入手できる「3D Sample Scene」は、HDRP や物理ベースのライティ
ングの入門用テンプレートとしてのプロジェクトです。これは軽量なプロジェクトで
容量が 100 メガバイトにも満たないため、いつでも気軽にロードして参照すること
ができる優れた HDRP サンプルです。

このガイドでは、このプロジェクトを使用して、HDRP のさまざまな機能を説明し
ます。

小さな部屋がつながった構成になっており、ライティングの設定が異なる 3 種類の
エリアがあります。日光を表すディレクショナルライトは、現実世界と同じ強度であ
る 100,000 ルクスに設定されており、各部屋のライティング環境に合わせてカメラ
の露出が補正されています。

WASD キーとマウスを使用して、FPS Controller を移動させてみましょう。

「3D Sample Scene」の環境を表すワイヤーフレーム

https://unity.com/ja/
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 — Room 1 は、頭上からの日光に照らされた円形の舞台です。デカールによって、
コンクリートの床に埃や水たまりが追加されています。

 — Room 2 は、空の光からのボリュメトリックライトシャフトのほか、ガラスケー
ス内の木の高度なマテリアルが追加されています。

 — Room 3 は、室内の人工照明とエミッシブマテリアルのディスプレイです。

HDRP の「3D Sample Scene」の詳細については、Unity テクニカルアーティスト
の Pierre Yves Donzallaz が執筆したこちらのブログ記事をご覧ください。このテン
プレートのシーンの詳細について説明しています。

「3D Sample Scene」は 3 つの部屋で構成されています。

このサンプルシーンは、HDRP の機能を説明するための軽量プロジェクトです。

https://unity.com/ja/
https://blog.unity.com/technology/explore-learn-and-create-with-the-new-hdrp-scene-template?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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その他の HDRP のサンプルコンテンツ

HDRP の「3D Sample Scene」には、参考になるプロジェクトが他にも用意されて
います。

「Auto Showroom」は本来ゲーミング向けのプロジェクトではありませんが、細部
まで作り込まれた自動車がリアルにライティングされている様子を見ることができま
す。インタラクティブなデモになっており、ステージのライト、車の塗装マテリアル、
背景を変更したりすることができます。このプロジェクトは Unity Hub で入手でき
ます。

「Spaceship Demo」は Visual Effect Graph のデモを目的としたプロジェクトで
すが、SF 的な環境で多数の HDRP 機能が使用されています。このプロジェクトは、
Unity の GitHub リポジトリからダウンロードできるほか、Steam からプレイアブル
を入手できます。

「Auto Showroom」テンプレート

「Spaceship」デモ

https://unity.com/ja/
https://github.com/Unity-Technologies/SpaceshipDemo
https://github.com/Unity-Technologies/SpaceshipDemo
https://store.steampowered.com/app/1605230/Spaceship__Visual_Effect_Graph_Demo/
https://store.steampowered.com/app/1605230/Spaceship__Visual_Effect_Graph_Demo/
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VR で HDRP を使用する場合は、「VR Alchemist Lab」が参考になります。このプロ
ジェクトでは、中世の西洋の小さな研究室の中で、インタラクティブなエフェクトが
使用されています。

映画のような絵作りやアニメーション映像の制作方法を学びたい場合は、Unity Hub 
から Cinematic Studio テンプレートをインストールしてください。Mich-L という
一風変わったショートムービーを例に、スタイリッシュなレンダリングと写実的なレ
ンダリングを組み合わせたシーン中のショットの設定方法やライティング方法を説明
しています。

HD レンダーパイプラインについても学べますので、このようなプロジェクトをぜひ
参照してください。

「VR Alchemist Lab」デモ

Cinematic Studio Sample

https://unity.com/ja/
https://github.com/Unity-Technologies/VRAlchemyLab
https://unity.com/demos/mich-l-cinematics?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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Project Settings
「Project Settings」（「Edit > Project Settings」） の「Graphics」、「HDRP Global 
Settings」、「Quality」には、欠かせない基本設定が数点あります。

注：「HDRP Default Settings」は、Unity 2021.2/HDRP 12 以降では「HDRP Global 
Settings」になっています。

「Graphics」設定

最上部の「Scriptable Render Pipeline Settings」フィールドは、すべての HDRP 
設定が保管されるディスク上のファイルを意味します。

プロジェクトごとに複数のパイプラインアセットを使用できます。各アセットが別々
の設定ファイルだと考えてください。たとえば、各種ターゲットプラットフォーム
（Xbox、PlayStation など）の専用設定を保管するために使用したり、プレイヤーが
ランタイム時に切り替えることができる個別のビジュアルクオリティーレベルを示す
ために使用したりできます。

Project Settings

https://unity.com/ja/
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「3D Sample Scene」の場合、まず「Settings」フォルダー内に「HDRPHighQuality」、
「HDRPLowQuality」、「HDRPMediumQuality」の各パイプラインアセットがあり
ます。さらに、「HDRPDefaultResources」フォルダーには「DefaultHDRPAsset」
があります。

「Quality」設定

「Quality」設定では、任意のパイプラインアセットを、事前に定義した品質のレベル
へ対応させることができます。最上部の「Level」を選択して、特定のレンダーパイ
プラインアセットをアクティベートします。これは「Rendering」オプションに表示
されます。

最上部でクオリティーレベルを選択し、パイプラインアセットを有効にします。

「3D Sample Scene」には、低品質、中品質、高品質のパイプラインアセットが含まれています。

https://unity.com/ja/
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デフォルト設定をカスタマイズしたり、品質レベルを追加したりした後で、追加のパ
イプラインアセットとペアリングできます。

品質レベルは、パイプライン内でアクティブ状態になっている特定のビジュアル機能
を表します。たとえば、1 つのアプリケーションに複数のグラフィックスレベルを作
成できます。ランタイム時には、プレイヤーがハードウェアに合わせてアクティブな
品質レベルを選択できます。

「Quality/HDRP」のサブセクションで、実際のパイプライン設定を編集できます。
Project ウィンドウでパイプラインアセットを選択し、インスペクターで設定を編集
することもできます。

パイプラインアセットの編集

https://unity.com/ja/
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HDRP の最適化

パイプラインアセットで多くの機能を有効にすればするほど、消費リソースも増える
点にはご注意ください。一般的には、目標とする効果を実現するために必要なものだ
けを使用するように、プロジェクトを最適化します。不要な機能がある場合は、オフ
にすることで、パフォーマンスを高めてリソースを節約できます。

不要な場合は無効にしても問題ない機能の典型例は次のとおりです。

 — 「HDRP Asset」：デカール、低解像度透明度、透明バックフェース /デプスプ
リパス /デプスポストパス、SSAO、SSR、コンタクトシャドウ、ボリュメトリッ
ク、サブサーフェススキャタリング、ディストーション

 — カメラの「Frame Settings」（メインカメラ、リフレクションのような統合エ
フェクトなどに使用するカメラ、またはカスタムしたエフェクトに対して使用
している追加カメラ）：屈折、ポストプロセス、ポストプロセス後、トランスミッ
ション、リフレクションプローブ、平面リフレクションプローブ、ビッグタイ
ルプリパス

HDRP 設定によるパフォーマンス強化について詳しくは、こちらのブログ記事でお読
みいただけます。

HDRP グローバル設定

プロジェクトの基本設定は、「HDRP Global Settings」セクション（バージョン 12 
より前では「HDRP Default Settings」セクション）で指定します。これらの設定は、
シーン内で、カメラの位置に応じてローカルまたはグローバルボリュームコンポーネ
ントを配置することによりオーバーライドできます（後述の「ボリューム」を参照）。

「Global Settings」は、最上部のフィールドで定義されている個別のパイプラインア
セットに保存されます。ここでデフォルトのレンダリングおよびポストプロセスのオ
プションを設定します。

HDRP 機能の有効化

プロジェクトを進めている時に、場合によっては、「Global」設定へ戻って、特定の
機能を切り替えてオンまたはオフに設定することが必要になる場合もあります。一部
の機能は、「HDRP Global Settings」内の対応するチェックボックスをオンにしてお
かないとレンダリングされることはありません。有効にするのは、必要な機能に限定
してください。レンダリングパフォーマンスやメモリ使用量に悪影響を与える可能性
があります。また、用途によって、ある設定は「Volume Profiles」に、また別の機
能は「Frame Settings」に表示されていたりします。

https://unity.com/ja/
https://www.google.com/url?sa=D&q=https://blog.unity.com/technology/get-acquainted-with-hdrp-settings-for-enhanced-performance%3Futm_source%3Ddemand-gen%26utm_medium%3Dpdf%26utm_campaign%3Drender-with-quality-and-flexibility%26utm_content%3Dthe-definitive-guide-to-lighting-in-hdrp-21-lts-ebook&ust=1651602300000000&usg=AOvVaw2dLpLiBXrsAGoALZzwgwUt&hl=en
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HDRP のさまざまな機能について調べる際は、「Project Settings」の右上にある検索
フィールドを活用しましょう。表示対象が関連するパネルのみに絞られるようになり、
検索用語が強調表示されます。
 

「HDRP Global Settings」で機能を有効にしたからといって、どのカメラでもいつで
もレンダリングできるわけではありません。「Projects Settings > Quality」で品質
レベルが選択されているレンダーパイプラインアセットについても、その機能をサ
ポートしていることを確認する必要があります。例えば、カメラでボリュメトリック
クラウドをレンダリングできるようにするには、「HDRP Global Settings > Frame 
Settings > Camera > Lighting」と、アクティブなレンダーパイプラインアセット
の「Lighting > Volumetrics」で、それらを切り替える必要があります。
 
 

フォワードレンダリン
グとディファードレン
ダリング
パイプラインアセットで HDRP 設定を指定する場合、通常は「Rendering」の「Lit 
Shader Mode」を開きます。ここでは、「Deferred」、「Forward」、または「Both」
を選択できます。これらは、パイプラインによるジオメトリのレンダリングおよびラ
イティング方法に関連する一連の処理であるレンダリングパスを表します。

デフォルトの HDRP 設定の変更

HDRP 機能の検索

https://unity.com/ja/
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レンダリングパスのカスタマイズ

「Lit Shader Mode」で「Forward」または「Deferred」を選択し、デフォルトのレ
ンダリングパスを設定します。

HDRP は柔軟性が高いので「Both」を選択することもできます。このオプションを
利用した場合はほとんどのレンダリングにレンダリングパスを 1 つ使用することと
なり、カメラごとにそのパスをオーバーライドできるようになります。ただし、こ
の方法では GPU メモリの使用量が多くなってしまいます。ほとんどのケースでは、
「Forward」か「Deferred」のいずれかを選択するのが有効です。

 — デフォルトですべてのカメラ
を対象にするには、「HDRP 
Default Settings」に移動し、
「Default Frame Settings」
を確認します。ここでは、
「Camera」、「Baked or 
Custom Reflection」、または
「Realtime Reflections」を対
象に設定できます。

 
「Rendering」グループで、「Lit 
Shader Mode」のレンダリン
グパスを設定します。

 — 特定のカメラでデフォルト設
定をオーバーライドするには、
「Custom Frame Settings」を
オンにします。

 
続いて、「Rendering」グルー
プで、「Lit Shader Mode」の
レンダリングパスをオーバー
ライドして変更します。

 

レンダリングパスに関する詳細

こうしたレンダリングパスの仕組みを理解し、「Lit Shader Mode」がパイプライン
のその他の設定にどのように影響するのかを確認することをおすすめします。

フォワードレンダリング

フォワードレンダリングでは、グラフィックスカードによって画面上のジオメトリが
頂点に分割されます。これらの頂点は、さらにフラグメントやピクセルに分割され、
それが画面にレンダリングされて最終的な画像が作成されます。

各オブジェクトは 1 度に 1 つずつグラフィックス API に渡されます。フォワードレ
ンダリングには、各ライトのコストが伴います。シーン内のライトが増えると、レン
ダリングの所要時間も長くなります。

カメラのカスタムフレーム設定の変更

https://unity.com/ja/
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フォワードレンダリングでは、別々のパスでライトを描画します。同一のゲームオブ
ジェクトに複数のライトを当てている場合は、ライトやオブジェクトが多数存在して
いると、大幅なオーバードローが生じ、動作が遅くなることがあります。
 
従来のフォワードレンダリングとは異なり、HDRP では、フォワードレンダラーに効
率面の改良が加えられています。たとえば、オブジェクトマテリアルごとに 1 つのパ
スで、複数のライトをまとめてカリングし、レンダリングします。ただし、それでも
プロセスのコストは比較的大きくなります。パフォーマンスに問題がある場合は、ディ
ファードシェーディングを使用することをおすすめします。

ディファードシェーディング

HDRP では、オブジェクト単位でのライティング計算が発生しないディファード
シェーディングも使用できます。ディファードシェーディングでは負荷の大きいレン
ダリングを後の段階に遅らせ、2 つのパスを使用します。

 フォワードレンダリングパス

ディファードシェーディングパス

https://unity.com/ja/
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1 つ目のパスである G-buffer ジオメトリパスでは、Unity がゲームオブジェクトを
レンダリングします。このパスは、複数のタイプのジオメトリプロパティーを取得し、
テクスチャーのセットに保管します（ディフューズ色およびスペキュラー色、サーフェ
スのスムースネス、オクルージョン、法線など）。

2 つ目のパスのライティングパスでは、Unity が G-buffer の完了後にシーンのライ
ティングをレンダリングします。つまり、シェーディングを遅らせます。ディファー
ドシェーディングパスはピクセルごとに反復され、個々のオブジェクトではなく、バッ
ファーを基準にライティング情報を計算します。

各レンダリングパスの技術的な違いの詳細については、HDRP に関するドキュメント
のフォワードおよびディファードレンダリングをご覧ください。

ディファードシェーディングでは、オブジェクトではなくバッファにライティングを適用します。 
それぞれのパスが、最終的にレンダリングされる画像に反映されます。

https://unity.com/ja/
https://docs.unity3d.com/Manual/RenderTech-DeferredShading.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Manual/RenderTech-DeferredShading.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-choose-unity-for-multiplatform&utm_content=optimize-game-performance-2020-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@11.0/manual/Forward-And-Deferred-Rendering.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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元のシーン

アンチエイリアシング
「Lit Shader Mode」のレンダリングパスは、アンチエイリアシングを使用してレン
ダリングからギザギザのエッジを取り除く方法に影響します。HDRP では、制作のニー
ズに合わせて複数のアンチエイリアシング手法を使用できます。

マルチサンプルアンチエイリアシング（MSAA）

マルチサンプルアンチエイリアシング（MSAA）は、PC ゲームで一般的なアンチエ
イリアシング手法です。個々のポリゴンのエッジを滑らかにする高性能ハードウェア
向けの手法で、Unity ではフォワードレンダリングを使用する場合のみ機能します。
最新の GPU のほとんどは、2x、4x、8x の MSAA サンプルに対応しています。

アクティブなパイプラインアセットで、「Lit Shader Mode」を「Forward Only」に
設定します。続いて、「Multisample Anti-aliasing Quality」で、「MSAA 2x」、「MSAA 
4x」、または「MSAA 8x」を選択します。値が大きいほどアンチエイリアシングの
質が上がりますが、動作は遅くなります。

これは、カメラビューでズームインしたときにより顕著になります。

MSAA の品質設定

https://unity.com/ja/
https://en.wikipedia.org/wiki/Multisample_anti-aliasing
https://en.wikipedia.org/wiki/Graphics_processing_unit
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ポストプロセスでのアンチエイリアシング

ポストアンチエイリアシングを次のように設定して、ポストプロセスの技術で設定し
たカメラにアンチエイリアシングを適用することもできます。

 — Temporal Anti-aliasing（TAA）では、過去と現在のフレームからの情報を組
み合わせ、現在のフレーム内のジャギーを取り除きます。この設定を使用する
ためには、モーションベクトルを有効にする必要があります。大半の場合 TAA 
は良い成果を生み出しますが、状況によって（コントラストのあるサーフェス
の前面でゲームオブジェクトが高速で移動した場合など）ゴースト上のアー
ティファクトが発生することがあります。HDRP10 では、一般的な TAA アー
ティファクトを削減するための改良が加えられています。Unity の実装ではゴー
ストの発生が抑制され、シャープネスが改善されたほか、他のソリューション
で見られるちらつきが防止されています。

 — Fast Approximate Anti-aliasing（FXAA）は、ハイコントラストの領域間の
ピクセルをブレンドするスクリーンスペースアンチエイリアシングアルゴリズ
ムです。比較的高速で、大規模な演算能力も不要ですが、画像の全体的なシャー
プネスは落ちる場合があります。

次の制約事項にご注意ください。

 — MSAA は、シーンのジオメトリをテクスチャーに保管するディファードシェー
ディングの G-buffer では利用できません。そのため、ディファードシェーディ
ングでは、いずれかのポストプロセスでのアンチエイリアシング手法（後述）
を使用する必要があります。

 — MSAA では、ポリゴンのエッジのエイリアシングのみを処理するため、シャー
プなスペキュラーライトが届く特定のテクスチャーやマテリアルに対するエ
イリアシングについては防ぐことができません。これが問題になる場合は、
MSAA と別で、ポストプロセスでのアンチエイリアシング手法（右側）を組み
合わせる必要があります。

MSAA 設定を適用した画像

https://unity.com/ja/
https://en.wikipedia.org/wiki/Jaggies
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@7.1/manual/Motion-Vectors.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://en.wikipedia.org/wiki/Spatial_anti-aliasing
https://en.wikipedia.org/wiki/Spatial_anti-aliasing
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注：ポストプロセスでのアンチエイリアシングをマルチサンプルアンチエイリアシン
グと組み合わせる際は、レンダリングコストに注意してください。いつでもビジュア
ルクオリティーとパフォーマンスのバランスがとれるように、プロジェクトは常に最
適化を心がけるようにしましょう。

ポストプロセスのアンチエイリアシング：FXAA、SMAA、TAA の各設定の結果を比較。

ディファードシェーディングを使用する際は、カメラのポストアンチエイリアシングを調整します。

 — Subpixel Morphological Anti-aliasing（SMAA）では、画像内の境界を検出
してから、ブレンドする特定のパターンを検出します。これによって、FXAA 
よりシャープな結果が生成されます。フラットスタイルやカートゥーン調のス
タイル、クリーンなアートスタイルに適しています。

https://unity.com/ja/
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ボリュームは、ボリュームコンポーネントが含まれたプレースホルダーオブジェクト
に過ぎません。ボリュームは、「GameObject > Volume」メニューから、プリセッ
トを選択することで作成できます。または、適切なコンポーネントを含めたゲームオ
ブジェクトを手動で作成します。

ボリュームコンポーネントは任意のゲームオブジェクトに追加できるため、ヒエ
ラルキーから見つけるのが困難になる場合があります。ライトエクスプローラー
（「Window > Rendering > Light Explorer > Volumes」）を使用すると、ロードされ
ているシーンのボリュームを見つけやすくなります。このインターフェースを使用し
て手早く調整することができます。

ライトエクスプローラーには、開いているシーン内のすべてのボリュームが一覧表示されます。

プリセットを使用してボリュームオブジェクトを作成

ボリューム
HDRP ではボリュームフレームワークを使用します。このシステムでは、シーンを分
割し、カメラの位置に合わせて特定の設定や機能を有効化できます。たとえば、この 
HDRP テンプレートレベルは 3 つに分かれており、それぞれに独自のライティング
設定があります。その形で、各部屋も別々のボリュームが内包しています。

それぞれにライティング条件が異なるスペースをボリュームが覆っています。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Volumes.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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ローカルボリュームでは、設定
を適用する限定的なスペース
を定義します。コライダーコン
ポーネントを使用して境界を決
定します。コライダーによっ
て FPS プレイヤーコントロー
ラーなどの物理ボディの動きが
妨げられないようにするには、
「IsTrigger」を有効にします。

このテンプレートシーンで
は、各部屋に、グローバル
設定をオーバーライドする 
BoxCollider を含むローカルボ
リュームがあります。

各部屋に、コライダーが「IsTrigger」に設定されたローカルボリュームが
あります。

グローバル Volume オーバーライド

 
ローカルとグローバル

コンテキストに合わせて、ボリュームコンポーネントの「Mode」を「Global」また
は「Local」に設定します。

グローバルボリュームは、境界のない「汎用」ボリュームとして使用できます。その
場合、シーン内のすべてのカメラに影響します。HDRP テンプレートシーンでは、レ
ベル全体の HDRP 設定のベースラインが VolumeGlobal によって定義されます。

https://unity.com/ja/
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ボリュームプロファイル

ボリュームコンポーネント自体には、実際のデータは含まれません。その代わり、ボ
リュームコンポーネントはボリュームプロファイルを参照します。これは、シーンを
レンダリングするための HDRP 設定を含むディスク上の ScriptableObject です。新
しいボリュームプロファイルを作成するには、「Profile」フィールドで、「New」ま
たは「Clone」ボタンを使用します。

「Profile」フィールドでボリュームプロファイルを切り替えるか、新しく作成します。

Room 2 には、ガラスケースの横の中央の明るい場所に小さな球面ボリュームがあり
ます。同様に、Room 3 には、入口の通路と、つり下げの照明の下の椅子があるエリ
アに、より小さなボリュームがあります。

特殊なライティング条件では小さいボリュームを使用します。
 
SampleScene では、ローカルボリュームによって「White Balance」、「Exposure」、
「Fog」がオーバーライドされます。明示的にオーバーライドされない要素は、すべ
てグローバルのデフォルト設定にフォールバックされます。

シーン内でカメラが動く際は、グローバル設定をオーバーライドするローカルボ
リュームにプレイヤーコントローラーが接触するまでは、グローバル設定が適用され
ます。

 

パフォーマンスに関するヒント

ボリュームは大量に使用しないようにしてください。各ボリュームの評価（ブレンディ
ング、立体化、オーバーライドの計算など）には、CPU コストが伴います。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@11.0/manual/Volume-Profile.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Manual/class-ScriptableObject.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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保存済みの別のプロファイルに切り替えることもできます。ボリュームプロファイル
をファイルとして使用することで、以前の設定を再利用したり、ボリューム間でプロ
ファイルを共有したりしやすくなります。

再生モード中にボリュームプロファイルに加えられた変更内容は、再生モードを終了
した後も残ります。

Volume オーバーライド

各ボリュームプロファイルでは最初、一連のプロパティーがデフォルト値に設定され
ています。この値を編集するには、Volume オーバーライドを使用し、個々の設定を
カスタマイズします。たとえば、Volume オーバーライドでは、ボリュームのフォグ、
プロセッシング、露出を変更できます。

ボリュームプロファイルを設定したら、「Add Override」をクリックし、プロファイ
ル設定をカスタマイズします。フォグのオーバーライドは次のようになります。

Volume オーバーライドとしてのフォグの例

Volume オーバーライドの各プロパティーでは、左側にチェックボックスがあり、そ
こで対象のプロパティーの編集を有効化できます。ボックスを無効のままにすると、
HDRP では、ボリュームの初期値が使用されます。

各ボリュームオブジェクトには、複数のオーバーライドを設定できます。それぞれの
オーバーライドで、必要に応じてプロパティーを編集できます。左上の「All」また
は「None」のショートカットを使用すると、オンとオフを一括で切り替えることが
できます。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@11.0/manual/Volume-Profile.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Volume-Components.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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オーバーライドのワークフロー

オーバーライドの追加は、HDRP の重要なワークフローです。プログラミングからの
継承という概念を理解していれば、Volume オーバーライドも理解しやすくなります。

上位レベルのボリューム設定は、下位レベルのボリュームのデフォルト設定として使
用されます。ここでは、HDRP のデフォルト設定がグローバルボリュームに渡されま
す。それがローカルボリュームの「ベース」として使用されます。

グローバルボリュームによって、HDRP のデフォルト設定がオーバーライドされま
す。次に、ローカルボリュームによってグローバルボリュームがオーバーライドさ
れます。「Priority」、「Weight」、「Blend Distance」（概要は後述）を使用して、ボ
リュームの重複に起因する競合を解消します。

特定のボリュームコンポーネントの現在の値をデバッグするには、「Rendering 
Debugger」の「Volume」タブを使用します。

HDRP のドキュメントで、完全な Volume オーバーライドのリストを確認できます。

ボリュームのデバッグ

Volume オーバーライドを使用して HDRP 機能を追加

https://unity.com/ja/
https://en.wikipedia.org/wiki/Inheritance_(object-oriented_programming)
https://en.wikipedia.org/wiki/Inheritance_(object-oriented_programming)
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.1/manual/Render-Pipeline-Debug-Window.html
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.1/manual/Render-Pipeline-Debug-Window.html
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Volume-Components.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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ブレンディングと優先度

レベルごとに複数のボリュームが必要な場合もあるため、HDRP ではボリューム間の
ブレンドが可能になっています。これにより、ボリューム間の遷移がスムーズになり
ます。

ランタイム時、HDRP はカメラ位置を基に、最終的な HDRP 設定に影響するボリュー
ムを判断します。

「Blend Distance」によって、ボリュームのコライダー外にどの程度離れたらフェー
ドオンまたはフェードオフを開始するかを指定します。「Blend Distance」の値を「0」
に設定すると即座に遷移が開始されます。正の値を設定すると、カメラが指定された
範囲内に入ったときに Volume オーバーライドによってブレンディングが開始され
ます。

ローカルボリュームが重複する場合は、「Blend Distance」、「Weight」、「Priority」を使用します。

「Blend Distance」を使用して、ボリューム周辺の遷移ゾーンを定義します。

ボリュームフレームワークは柔軟性が高く、必要に応じてボリュームとオーバーライ
ドを組み合わせることができます。同一スペース内に複数のボリュームが重複してい
る場合、「Priority」に基づいて、優先されるボリュームが決定されます。この値が
大きいほど優先度が高くなります。

通常は、あいまいになるのを防ぐために「Priority」を明示的に設定します。明示的
に設定しない場合、「Priority」が同じであれば作成された順番で優先順が決定されま
すが、それによって予期しない結果が生じることがあります。

https://unity.com/ja/
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露出
HDRP は、現実世界のライティングモデルを使用して各シーンをレンダリングします。
そのため、従来の写真術で使われてきたプロパティーと類似するプロパティーが多数
あります。

露出値を理解する

露出値（EV）は、カメラのシャッタースピードと F 値（レンズの開口部または絞り
のサイズ）の組み合わせによって決まる数値です。明度を最適化し、シャドウとハイ
ライトの両方でディテールを高精度に捉えるためには、露出を適切に設定する必要が
あります。露出を適切に設定しないと、画像の露出過多や露出不足が生じ、期待する
結果が得られなくなります。

HDRP での露光範囲は、多くの場合、以下の範囲内に収まります。

 
露出値が大きくなるほどカメラに入る光が少なくなり、より明るい状況に適します。
露出値 13 から 16 の範囲は、晴天の日中の屋外に適しています。一方、暗く、月が
ない夜空には、露出値 -3 から 0 が適しています。

実際のカメラ設定で、次のようなさまざまな要素を変更し、露出値を調整できます。

— シャッタースピード：画像センサーを光にさらす時間

— F 値：絞り /レンズ開口部のサイズ

— ISO：フィルム /センサーの感度

露出オーバー、露出アンダー、適正露出の比較。

月のない夜から、明るい晴天日までの露出範囲

https://unity.com/ja/
https://en.wikipedia.org/wiki/Shutter_speed
https://en.wikipedia.org/wiki/F-number
https://en.wikipedia.org/wiki/Exposure_(photography)
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写真家の間では、これは「露出の三角形」と呼ばれています。Unity では、現実のカ
メラと同様、これらの数値をさまざまな形で組み合わせて同じ露出値を実現できます。

 
HDRP では、すべての露出値が EV100 で表現されます。これにより、感度は  
100 International Standards Organisation（ISO）フィルムの感度に固定されます。
 

 
露出値の計算式

以下の計算式によって、実際の露出値が計算されます。 

 
これは 2 を底とする対数スケールです。露出値が 1 単位増加すると、レンズに入る
光の量が半分に減少します。

露出の三角形

露出の計算式

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Physical-Light-Units.html#EV?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://en.wikipedia.org/wiki/Film_speed
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HDRP では、実際の画像の露出に合わせることができます。カメラやスマートフォン
でデジタル写真を撮影するだけで、その画像からメタデータを取得し、F 値、シャッ
タースピード、ISO を特定できます。

そのうえで、上記の計算式によって露出値を計算します。Exposure オーバーライド
（後述）と同じ値を使用すると、レンダリングされる画像は、現実の画像と同じ露出
になります。

この方法を使うことで、レベルのライティングを設定する際にデジタル写真を参照情
報として使用できます。その画像を完全に再現することが目的とは限りませんが、実
際の写真に合わせることによって、勘に頼ることなくライティングを設定できます。

 
Exposure オーバーライド

HDRP では、露出は Volume オーバーライドです。ローカルボリュームまたはグロー
バルボリュームに追加することで利用可能なプロパティを確認できます。

「Mode」ドロップダウンで、「Fixed」、「Automatic」、「Automatic Histogram」、
「Curve Mapping」、「Physical Camera」のいずれかを選択できます。

「Compensation」では、露出を変更、調整できます。通常はこれを利用して小さな
調整を加え、レンダリングされた画像の「ストップ（絞り）」をわずかに上下させます。

「Fixed」モード

「Fixed」モードでは、露出値を手動で設定できます。

デジタル写真の Exif データを基に露出を合わせます。

「Fixed」モードの露出

https://unity.com/ja/
https://en.wikipedia.org/wiki/Stopping_down
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「Fixed Exposure」スライダーの目盛りが参考になります。また、右側のアイコン
をクリックするとプリセットのドロップダウンが表示されます（「Sunlit Scene」の  
13 から「Moonless Scene」の -2.5 まで）。フィールドの値
を任意の数値に設定することもできます。

「Fixed」モードはシンプルですが、柔軟性に劣ります。通常は、
ライティングが比較的均一で、1 つの露出値で対応できるボ
リュームやシーンを使用する場合に効果的です。
 
「Automatic」モード
 
「Automatic」モードでは、画面上の明度の範囲に応じて露出が動的に設定されます。
この設定は、人間の目が暗さの変化に適応し、黒と認識されるものを再定義する仕組
みと非常に似ています。

「Automatic」モードは、さまざまなライティングの状況下で有効ですが、カメラが
非常に暗い場所や非常に明るい場所を向いたときに、意図せず画像の露出過多や露出
不足が生じる場合もあります。

露出レベルを適切な範囲内に収めるためには、「Limit Min」と「Limit Max」を使用
します。テストプレイを行って、レベル全体で上限値が適切な露出の範囲内に収まっ
ているか確認してください。

「Metering Mode」をマスクオプションと組み合わせると、フレーム内のどの部分を
自動露出に使用するか決定できます。

「Adaptation」モードでは、暗い場所と明るい場所の間をカメラが遷移する際に、自
動露出をどのように変化させるかを制御します。スピードを調整するオプションを利
用します。人間の目と同じように、非常に暗いエリアから非常に明るいエリアにカメ
ラが移動すると（またはその逆）、一時的にどこを向いているのかわからなくなる場
合があります。

「Fixed」モードの露出の
プリセット

「Automatic」モードの露出

https://unity.com/ja/
https://en.wikipedia.org/wiki/Adaptation_(eye)
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「Metering Mode」のオプション

「Automatic」、「Automatic Histogram」、「Curve Mapping」モードでは、「Metering 
Mode」を使用して、フレーム内のどの部分を露出の計算に使用するかを制御します。
「Metering Mode」は次のように設定できます。

— 「Average」：フレーム全体を使用して露出を測定します。

— 「Spot」：画面の中央部のみを使用して露出を測定します。

— 「Center Weighted」：画面の中央部にあるピクセルを優先的に使用し、フレー
ムの端に向かうにつれて使用率を減らしていきます。

— 「Mask Weighted」：指定した画像（「Weight Texture Mask」）を使用して、
露出を測定する際にどのピクセルを最も重視するかを決めます。

— 「Procedural Mask」：手続き型で生成されたテクスチャーを基に露出を評価し
ます。オプションを使用して、中心の位置、半径、ぼかし具合を変更できます。

Automatic Histogram
 
「Automatic Histogram」モードは、「Automatic」モードをさらに発展させたもの
です。露出設定時に画像のヒストグラムを計算し、最も暗いピクセルと最も明るい
ピクセルを無視します。

 

「Metering Mode」の「Spot」と「Center Weighted」

「Automatic Histogram」モード

https://unity.com/ja/
https://en.wikipedia.org/wiki/Image_histogram
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露出の計算から非常に暗いピクセルと非常に明るいピクセルを排除することで、フ
レーム内に極端に明るいピクセルや暗いピクセルがある場合でも、安定した露出を得
られます。これにより、発光が強いサーフェスや黒いマテリアルがあったとしても、
レンダリング結果で深刻な露出過多や露出不足が生じることはありません。

「Histogram Percentages」設定を使用すると、ヒストグラム内の指定したパーセン
テージ範囲に含まれないデータをすべて無視できます（たとえば、ヒストグラムの左
端と右端から、最も明るいピクセルと最も暗いピクセルを除外することができます）。

「Curve Remapping」を使用すると、露出曲線もリマップできます（後述の「Curve 
Mapping」を参照）。

カーブマッピング

「Curve Mapping」モードは、「Automatic」モードのもう 1 つのバリエーションです。

この設定では、曲線の X 軸は現在の
露出を表し、Y 軸はターゲットとす
る露出を表します。露出カーブの再
マップによって、非常に高精度な結
果を生成できます。

カーブを変えて露出を調整します。

「Automatic Histogram」では、ヒストグラム中央部にあるピクセルを基に露出を計算します。

「Curve Mapping」モード

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@10.5/manual/Override-Exposure.html#AutomaticProperties?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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Physical Camera

写真に詳しい方は、「Physical Camera」モードを使用すると、カメラのパラメーター
を設定しやすいかもしれません。

Exposure オーバーライドの「Mode」を「Physical Camera」に切り替えてから、
「Main Camera」を確認します。
 

「Physical Camera」を有効にします。インスペクターに以下のプロパティが表示さ
れます。

露出関連で重要なのは、「ISO」（感度）、「Aperture」（F 値）、「Shutter Speed」です。
参照用の写真に合わせる場合は、画像の Exif データから適切な設定をコピーします。
または、こちらの表を参考にすると、F 値とシャッタースピードを基に露出値を推測
できます。

「Physical Camera」モード

カメラの「Physical Camera」プロパティー

https://unity.com/ja/
https://docs.unity3d.com/Manual/PhysicalCameras.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://en.wikipedia.org/wiki/Exif
https://en.wikipedia.org/wiki/Exposure_value#EV_as_an_indicator_of_camera_settings
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「Physical Camera」のその他のパラメーター

露出とは無関係ですが、「Physical Camera」のその他のプロパティも、現実世界の
カメラの属性に合わせる助けになります。

たとえば、Unity（および他の多数の 3D アプリケーション）では通常、有効視野
（FOV）を使用して、カメラがワールド内を一度に撮影できる範囲を決定します。

しかし、実際のカメラでは、有効視野はセンサーのサイズとレンズの焦点距離によっ
て決まります。直接有効視野を設定するのではなく、「Physical Camera」の設定を
使用すると、実際のカメラのデータの「Sensor Type」、「Sensor Size」、「Focal 
Length」を入力できます。データを入力すると、それに対応する有効視野の値が自
動的に算出されます。

実際の写真に合わせて露出を設定す
るには、その画像ファイルに含まれ
るカメラのメタデータを利用します。
Windows と macOS の両方で、デジ
タル画像から Exif データを読み取る
ことができます。そのうえで、対象
のフィールドをバーチャルカメラに
コピーできます。

注：場合によっては、メタデータか
らカメラのメーカーとモデル名を確
認し、そのメーカーのウェブサイト
で正確なセンサーのサイズを調べる
必要があります。こちらの記事には、
一般的な画像センターのフォーマッ
トの推定が記載されています。

下にあるパラメーターのいくつかは、
被写界深度ボリュームに影響します。

 
 
 
Unity 2021 LTS では、カ
メラのインスペクターか
ら「Focus Distance」 を
制御できます。被写界深度
ボリュームコンポーネン
ト で、「Focus Mode」 と
「Focus Distance Mode」
を「Physical Camera」に
設定します。

焦点距離、センサーサイズ、有効視野の関係 

https://unity.com/ja/
https://docs.unity3d.com/Manual/PhysicalCameras.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://en.wikipedia.org/wiki/Field_of_view
https://en.wikipedia.org/wiki/Image_sensor_format
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「Blade Count」、「Curvature」、「Barrel Clipping」を使用して、カメラの絞りの形状
を変更できます。このパラメーターは、これによって、被写界深度ボリュームコンポー
ネントによって生じる「ボケ」の見え方に影響します。

 
 

 
ライト
HDRP には、シーン内のイルミネーションの制御に役立つさまざまなタイプのライトや
形状が用意されています。

ライトのタイプ

Unity の他のレンダーパイプラインと同様に、以下のタイプのライトを利用できます。

— ディレクショナル：無限遠に位置する光源からの光のような特性を持ちます。強
度が落ちない完全な平行光線です。ディレクショナルライトは、多くの場合、日
光として使用されます。一般的に、屋外のシーンでは、これがキーとなるライト
です。

— スポット：現実世界のスポットライトに似ており、円錐、ピラミッド、ボックス
といった形状があります。スポットは、前方 Z 軸に沿って、円錐 /ピラミッド形
状のエッジに向かって落ちていきます。

— ポイント：空間内のある 1 点からすべての方向に光を放つ全方向性ライトです。
ランプやキャンドルなどの放射光源に適しています。

— Area：特定の形状（矩形、チューブ、またはディスク）のサーフェスから光を投
影します。エリアライトは、窓や蛍光灯のような、中央部の強度が均一である面
的な光源においての使用に適しています。

「Range」を使用して、スポットライト、ポイントライト、エリアライトをどのように
減衰させるかを調整できます。多くの HDRP ライトは、現実世界の光源と同じように、
逆 2 乗の法則に従って減衰します。

物理カメラのパラメーターを使用して絞りの形状を設定します。5 枚羽根絞りの場合、五角形（左）または円形（右）の 
ボケを表現できます。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Post-Processing-Depth-of-Field.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://en.wikipedia.org/wiki/Inverse-square_law
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形状

スポットライトとエリアライトには、各ライトの減衰方法を制御するために独自の形
状が追加されています。

HDRP のスポットライトでは、3 つの形状を使用できます。

— Cone（円錐）：1 点から円錐形に広がる光を投影します。「Outer Angle」（角度）
と「Inner Angle」（パーセンテージ）を使用して、円錐形の形と角度減衰を調
整します。

— Pyramid（ピラミッド）：1 点から四角錐型に広がる光を投影します。「Spot 
Angle」と「Aspect Ratio」を使用して四角錐の形状を調整します。

— Box（ボックス）：矩形のボリューム全体へ均一に光を投影します。X サイズと 
Y サイズによって基部となる長方形を定めて、「Range」によって Y 次元を調
整します。この光は、「Range Attenuation」がオンになっていなければ減衰
しないようになっているので、ボックスの範囲内で日光のシミュレーションな
ども行うことができます。

HDRP のエリアライトでは、3 つの形状を使用できます。

— Rectangle（矩形）：矩形の形状からローカルの正の Z 方向に、定義された
「Range」まで光を投影します。

— Tube（チューブ）：1 本の線から全方向に、定義された「Range」まで光を投
影します。このライトは「Realtime Mode」でのみ使用できます。

— Disc（ディスク）：ディスク型の形状からローカルの正の Z 方向に、定義され
た「Range」まで光を投影します。このライトは「Baked Mode」でのみ使用
できます。

HDRP のスポットライトの形状

HDRP のエリアライトの形状

https://unity.com/ja/
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色と温度

HDRP のすべてのタイプのライトに、ライトの外観を定義する「Emission」プロパ
ティーがあります。

「Light Appearance」を「Color」に切り替えると、RGB カラーを指定できます。
または、これを「Filter and Temperature」に変更し、より物理的に正確なデータ
を入力できます。

色温度では、ケルビン度に基づいて色を設定します。詳しくは、ライティングと露出
のチートシートをご覧ください。

別の色を追加してフィルターのように作用させることで、別の色相を使ってライトに
色を付けることもできます。これは、現実の写真撮影でカラージェルフィルターを使
用する方法と似ています。

追加のプロパティ

インスペクターのプロパティの右上にあるその他のアイテムメニュー（⋮）の下にも、
高度なコントロールがいくつか用意されています。「Show Additional Properties」
を選択すると、追加のオプションが表示されます。

「Affect Diffuse」、「Affect Specular」などのトグルがあります。たとえば、カット
シーンや映画のようなライティングでは、明るいハイライトを制御するライトと、よ
りソフトなディフューズライトを生成するライトを分離することができます。

「Emission」の「Light Appearance」プロパティを変更

ケルビン温度で表された色温度

各ライトに追加のプロパティがあります。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Light-Component.html#Emission?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/ScriptReference/Color.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://en.wikipedia.org/wiki/Color_temperature
https://en.wikipedia.org/wiki/Color_gel
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「Intensity Multiplier」を使用して、ライトの元の強度の値を変更せずに全体的なラ
イトの強度を調節することもできます。複数のライトを一括で明るくしたり暗くした
りするのに便利です。

ライトレイヤー

HDRP では、ライトレイヤーを使用して、ライトの影響範囲をシーン内の特定のメッ
シュに限定できます。これは、ライトコンポーネントと MeshRenderer に関連付け
ることができる LayerMask になります。

ライトのプロパティーで、「More Options」ボタンをクリックします。「General」
に「Light Layer」ドロップダウンが表示されます。ライトに関連付ける LayerMask 
を選択します。

「Light」プロパティーで、「More Items」メニュー（☰）から「Show 
Additional Properties」を選択します。「General」に「Light Layer」ドロッ
プダウンが表示されます。ライトに関連付ける LayerMask を選択します。

ディフューズライティングとスペキュラーライティングの設定を細かく調整できます。

「Light Layer」の選択

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Light-Layers.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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次に、「Rendering Layer Mask」を使用して MeshRenderer を設定します。対応す
る LayerMask 上のライトのみがメッシュに影響します。これは、光漏れを解消し、
意図した対象のみに確実にライトを当てるために欠かせない機能です。また、カット
シーンのライティングを設定するワークフローにこの機能を組み込むことで、映画的
な演出でキャラクターだけに専用のライトが当たるようにすることができます。

たとえば、建物内部のライトが意図せず壁を貫通し、屋外に出るのを防ぎたい場合は、
屋内用と屋外用のライトレイヤーを設定します。この機能を使えば、ライトの構成を
細かく制御できます。

ライトレイヤーを設定するには、「HDRP Default Settings」にアクセスします。
「Layers Names」セクションで、「Light Layer 0」から「Light Layer 7」までの名
前をそれぞれ文字列で設定できます。

ライトのプロパティに関する全体のリストを含めて、この詳細については、 
Light コンポーネントに関するドキュメントをご覧ください。

「Rendering Layer Mask」を設定し、特定のライトのみがメッシュに適用されるようにします。

「HDRP Default Settings」の「Layers Names」

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Light-Component.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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ライトアンカー

Unity 2021 LTS 以上には、ライトアンカーシステムが備わっていて、カメラと被写
体の角度と距離を制御することでライトを簡単に設定できます。また、一般的なライ
ティング角度を 9 つのプリセットから選択できます。

キャラクターや小道具の周りに複数のライトを使用して、映画のショット、シーン、
製品を照らす必要がある場合、ライトアンカーコンポーネントで、アンカーターゲッ
トの周りのスクリーンスペースで高速なライト操作を利用できます。

まず、ライトアンカーが動作するためには、カメラがメインカメラとしてタグ付
けされている必要があります。そのうえで、制御対象のスポットライトに「Light 
Anchor」コンポーネントを追加します。被写体にライトを合わせると、その位置が
スポットライトのアンカーポイントになります。アンカーポイントとスポットライ
トとの間の距離は、「Distance」で増やします。後は、ゲームビュー内でライトの
「Orbit」、「Elevation」、「Roll」を調整すれば、アンカーポイントの周りでライト位
置を調整できます。シーンビューでライトの「Transform」を手動で調整する必要
はありません。

詳細については、ライトアンカーについて紹介するこちらのプレゼンテーションを参

照してください。

Light Anchor コンポーネント

ライトのトランスフォームを直接変更する代わりに、ライトアンカーを使用してライトに狙いを定めます。

https://unity.com/ja/
https://youtu.be/p48rNiJBFG0?t=1258?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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物理ベースのライト単位
と強度
HDRP では、物理ベースのライト単位（PLU）を光の強度の測定に使用します。これ
は、カンデラ、ルーメン、ルクス、ニトなど、現実世界での照度の SI 測定単位と一
致しています。PLU では、正確性を確保するため、Unity の 1 単位は 1 メートルに等
しいことが前提になっていることにご注意ください。

単位

物理ベースのライト単位には、光束と照度の両方の単位が含まれる場合があります。
光束とは光源から放出される光の総量であり、照度とはオブジェクトに当たる光の総
量を指します（単位面積あたりの光束で表されるのが一般的）。

商用のライティングや写真の分野では、用途によって使用される単位が異なる場合が
あります。そのため、Unity では互換性を確保するために、次のように複数の物理ベー
スのライト単位に対応しています。

— カンデラ：1 単位が、1 本のろうそくの光束に相当します。燭（燭光）などの
呼称も一般的です。

— ルーメン：SI の光束単位で、1 ステラジアン（立体角）に対する 1 カンデラの
光束と定義されます。ルーメンは、商用電球の仕様によく見られます。Unity 
のスポット、ポイント、エリアライトで使用します。

— ルクス：1 平方メートルのエリアに 1 ルーメンの光を放出する光源が、照度  
1 ルクスに相当します。現実世界で光を測定する際は、ルクスを読み取るのが
一般的です。通常、Unity のディレクショナルライトではこの単位を使用します。

— ニト：1 平方メートルあたり 1 カンデラに相当する照度単位です。ディスプレ
イデバイスや LED パネル（テレビやモニターなど）では、明るさをニト単位
で測定するのが一般的です。

— EV100：EV100、つまり露出値 100 ISO フィルムに相当する強度を使用します 
（前述の露出値の計算式を参照）。露出を上げると、対数的な計算により、ライ
ティングが倍増します。

現実世界の光源を再現するには、技術仕様に記載されている単位に切り替え、適切な
光束または輝度を設定します。HDRP によって物理ベースのライト単位に合わせるこ
とで、勘に頼らずに強度を設定できます。

アイコンをクリックし、「Exterior」、「Interior」、「Decorative」、「Candle」のいず
れかのプリセットを選択します。特定の値に合わせる必要がない場合は、このような
設定から始めることをおすすめします。

https://unity.com/ja/
https://en.wikipedia.org/wiki/International_System_of_Units
https://en.wikipedia.org/wiki/SI
https://en.wikipedia.org/wiki/Steradian
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ライティングと露出の一般的な値

以下のチートシートには、現実世界の一般的な光源の色温度の値とライトの強度がま
とめられています。また、さまざまなライティングシナリオに合った露出値も紹介さ
れています。

一般的なイルミネーションの値をまとめた詳細な表については、物理ベースのライト
単位に関するドキュメントをご覧ください。
 

IES プロファイルとクッキー
 
IES プロファイルを使用すると、ポイント、スポット、エリアライトの減衰を、現実
世界の光に近い形で再現できます。これは、特定の製造元の仕様をライトのパターン
に適用するライトクッキーのように機能します。IES プロファイルを使用すれば、ラ
イトのリアリティをさらに高めることができます。

ライティングと露出のレベルに関するガイダンス ライティングと露出のレベルに関するガイダンス

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Light-Component.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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IES プロファイルを「Assets > Import New Asset」からインポートします。インポー
ターによって、適切な強度でライトのプレハブが自動的に作成されます。続いて、プ
レハブをシーンビューまたはヒエラルキーにドラッグし、色温度を調整します。

IES プロファイルのソースの例は次の
とおりです。

実際の製造元
— Philips
— Lithonia Lighting
— Efficient Lighting Systems
— Atlas
— Erco
— Lamp
— Osram

アーティストのソース
— Renderman

IES プロファイルのインポーターの詳細については、ドキュメントをご覧ください。

環境ライティング
現実世界では、光は反射して散乱します。空と地面が環境の光へ影響しています。こ
れは大気と地表の間で無差別に跳ね返って散った光子が、最終的に人の目に入ってい
くからです。

HDRP では、「Visual Environment」のオーバーライドを使用して、シーンの空と環
境光を定義できます。

「Ambient Mode: Dynamic」 を 使 用 し て、 空 の ラ イ テ ィ ン グ を、「Visual 
Environment」の「Sky > Type」に表示される現在のオーバーライドに設定します。
または、「Ambient Mode: Static」を使用する場合は、「Lighting」ウィンドウの
「Environment」タブの空の設定がデフォルトになります。

IES プロファイルとインポート設定

さまざまなライトに適用される IES プロファイル

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/IES-Importer.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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https://renderman.pixar.com/ies-profiles
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/IES-Importer.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Visual-Environment.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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他の光源を無効にしている場合でも、SampleScene は「Visual Environment」の環
境光に照らされます。

HDRI Sky

環境ライティングのみ：日光のディレクショナルライトが無効ですが、 
空には環境光が残っています。

直接的な日光と環境ライティングの組み合わせ

太陽のキーとなるライトを追加することで、シーンの全般的なイルミネーションが決
まります。環境光は、シャドウエリアを照らして、不自然に暗くならないようにする
のに役立ちます。

HDRP には、空を生成する手法が 3 種類あります。「Type」を「HDRI Sky」、「Gradient 
Sky」、または「Physically Based Sky」のいずれかに設定します。続いて、「Sky」
メニューから適切なオーバーライドを追加します。

「Visual Environment」の空を適用すると、バーチャルワールド全体が、明るく照ら
された巨大な球体で囲まれたような状態になります。この球体の色付きのポリゴン
が、空、地平線、地面からの全般的なライトを提供します。

HDRI Sky

「HDRI Sky」では、ハイダイナミックレンジの写真から作成したキューブマップを使
用して空を表現できます。HDRI については、無料のソースや低コストのソースがオ
ンラインに多数あります。出発点としては、アセットストアにある Unity HDRI Pack 
が適しています。
 
挑戦してみたいと思っている方のために、自分で HDRI を撮影するためのガイドも用
意しています。

https://unity.com/ja/
https://en.wikipedia.org/wiki/High-dynamic-range_imaging
https://assetstore.unity.com/packages/2d/textures-materials/sky/unity-hdri-pack-72511?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook#description
https://docs.unity3d.com/2017.4/Documentation/uploads/ExpertGuides/High_Dynamic_Range_Imaging_HDRI.pdf?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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HDRI アセットをインポートしたら、「HDRI Sky」のオーバーライドを追加し、「HDRI 
Sky」アセットをロードします。「Distortion」、「Rotation」、「Update Mode」のオ
プションを調整することもできます。

空はイルミネーションのソースになるため、「Intensity Mode」を指定してから、対
応する「Exposure/Multiplier/Lux」の値を選択して環境ライティングの強度を制御
します。強度と露出の値の例については、前述のライティングと露出のチートシート
を参照してください。

 
 

 
クラウドレイヤーのアニメーション化

HDRI マップを手続き型またはフローマップを使って歪ませることで、HDRI Sky を
アニメーション化することができます。静的 HDRI で風のエフェクトを模したり、よ
り細かい VFX を作成したりすることができます。

 
Gradient Sky

「Visual Environment」で「Gradient Sky」を選択すると、カラーランプを使用して
背景の空を近似します。続いて、「Gradient Sky」のオーバーライドを追加します。
「Top」、「Middle」、「Bottom」を使用して、グラデーションの色を指定します。

カラーランプを「Gradient Diffusion」とブレンドし、ライティングの強さの
「Intensity」を調整します。

キューブマップとして球体の内部に適用された HDRI Sky

「Gradient Sky」では、「Top」、「Middle」、「Bottom」の色をブレンドします。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Gradient-Sky.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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Physically Based Sky

グラデーションより大幅にリアル
さを高めたい場合は、「Physically 
Based Sky」のオーバーライドが
有効です。これにより、ミー散乱
やレイリー散乱などの現象を再現
した空が手続き型で生成されます。
この空では、大気を通って分散す
る光のシミュレーションが行われ、
自然な空の配色が再現されます。
「Physically Based Sky」では、正
確なシミュレーションを行うため
にディレクショナルライトが必要
です。

色のヒント

地面の色は、オブジェクトがリフレクションプローブの影響を受けない実際の地面 
（地形など）の平均的な色に合わせて選んでください。

手続き型で生成された空（「Fountainebleau」デモより）

「Physically Based Sky」のオーバーライド

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Physically-Based-Sky.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Physically-Based-Sky.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://en.wikipedia.org/wiki/Mie_scattering
https://en.wikipedia.org/wiki/Rayleigh_scattering
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フォグと大気散乱
スモーク、フォグ、もやは、映画的な画面作りの定番のツールです。奥行きや立体感
を加えてライティングを演出したり、趣のある雰囲気を創出したりするのに役立ちま
す。HDRP では、フォグを使用して同様の効果を実現できます。

不透明度は、オブジェクトとカメラの距離に応じます。フォグを利用すると、カメラ
のファークリップ面を非表示にして、遠くにあるジオメトリをシーンにブレンドする
こともできます。

「Base Height」と「Maximum Height」を使用して、低い位置に漂うフォグを表現します。

https://unity.com/ja/
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グローバルフォグ

HDRP では、「Fog」のオーバーライドとしてグローバルフォグを実装しています。
この例では、カメラとの距離とワールド空間の高さに合わせて、フォグが急激に
フェードしていきます。

「Physically Based Sky」のオーバーライド

Fog Attenuation Distance

シーン内のボリュームで「Fog」のオーバーライドを設定します。「Base Height」
では、一定の濃いフォグが上方向に向かうにつれ、薄くなり始める境目を指定しま
す。この値を上回ると、「Maximum Height」に到達するまで、フォグの密度が急
激にフェードしていきます。
 
同様に、「Fog Attenuation Distance」と「Max Fog Distance」では、カメラから
距離が離れるにつれ、フォグをどのようにフェードさせるのかを設定します。「Color 
Mode」は、「Constant Color」と既存の「Sky Color」のどちらかに設定します。

「Volumetric Fog」を有効にすると、大気散乱のシミュレーションが行われます。
「Lighting」の「Frame Settings」（カメラの下か、「HDRP Default Settings」内）
で、「Fog」と「Volumetrics」がオンになっていることを確認します。また、「HDRP 
Pipeline Asset」で「Volumetric Fog」も有効にします。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Fog.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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「Volumetric Fog Distance」では、カメラのニアクリップ面からボリュメトリック
ライティングバッファーの背部までの距離（メートル単位）を設定します。これによ
り、大気中に浮遊物質が満たされ、範囲内のゲームオブジェクトが部分的に隠れます。

ボリュメトリックライティング

ボリュメトリックライティングによって、日没時の雲の背後や植生の間から射す光芒
など、印象的な太陽光線をシミュレーションでレンダリングできます。

それぞれの Light コンポーネント（エリアライト以外）に、「Volumetrics」グルー
プがあります。「Enable」をオンにしてから、「Multiplier」と「Shadow Dimmer」
を設定します。「Real-time」または「Mixed Mode」のライトを使用すると、ボリュ
メトリックフォグ内に「薄明光線」が生成されます。「Multiplier」で強度を調整し、
「Shadow Dimmer」を使用して、シャドウを投影するサーフェスがライトを遮る具
合を設定します。
 

「Light」コンポーネントの「Volumetrics」

ボリュメトリックフォグは、より正確に前景のジオメトリを保持します。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Volumetric-Lighting.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://en.wikipedia.org/wiki/Sunbeam
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ボリュメトリックライティングが、ボリュメトリックフォグのエリアを印象的に照らしています。

このサンプルシーンの Room 2 では、空の光とボリュメトリックフォグが使用され
ています。ガラスケースのフレームによって、天井からの太陽光線に伴うボリュメト
リックシャドウが形成されています。「Shadow Dimmer」と「Multiplier」の値を高
めると、エフェクトが強くなります。

天井のスポットライトに適用されたボリュメトリックライティング

https://unity.com/ja/
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ローカルボリュメトリックフォグはバウンディングボックスに表示されます

これはボリュームシステムの外にある別個のコンポーネントです。メニューから「Local 
Volumetric Fog」のゲームオブジェクトを作成（「GameObject > Rendering > Local 
Volumetric Fog」）するか、「Hierarchy」を右クリックします（「Rendering > Local 
Volumetric Fog」）。

これにより、フォグが満ちたバウンディングボックスが生成されます。サイズ、軸の
コントロール、ブレンディング /フェーディングのオプションを調整します。

ローカルボリュメトリックフォグ

HDRP では、「Fog」のオーバーライドよりも細かいフォグエフェクトが必要な場合
に、「Local Volumetric Fog」（HDRP 12 より前のバージョンでの呼称は「Density 
Volume」コンポーネント）を利用できます。

「Local Volumetric Fog」コンポーネント

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Local-Volumetric-Fog.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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「Local Volumetric 3D Texture Samples」の「Density Mask Texture」

アニメーションの「Scroll Speed」を追加し、「Tiling」を調整します。以上で、ボリュ
メトリックフォグを徐々にシーン内に描画できます。

注：HDRP では、ローカルボリュメトリックフォグをボクセル化してパフォーマン
スを高めます。ただし、ボクセル化によって外観が非常に粗くなる場合があります。
エイリアシングを低減するためには、「Density Mask Texture」を使用し、「Blend 
Distance」を上げてフォグのエッジを滑らかにします。
 
HDRP バージョン 12 以降では、「HDRP Pipeline Asset」で最大 256×256×256 の
ローカルボリュメトリック解像度を有効にできるため、より正確で大規模なエフェク
トが可能となります。

デフォルトではフォグは一様ですが、3D テクスチャーを「Density Mask Texture」
サブセクションの「Texture」フィールドに適用できます。これにより、ユーザー
はより柔軟にフォグの外観をコントロールできます。Package Manager の「Local 
Volumetric 3D Texture Samples」からサンプルをダウンロードするか、ドキュメ
ントの手順に即して密度マスクを作成します。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Local-Volumetric-Fog.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Local-Volumetric-Fog.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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雲
空は雲がなければ完全とはいえません。HDRP 12 以降では、クラウドレイヤーシス
テムで自然な外観の雲を生成することにより、Sky と Visual Environment のオー
バーライドを補間することができます。「Volumetric Clouds」は、ライティングや風
に反応して、実際の厚みを持ったリアルな雲を作り出します。
 
 
クラウドレイヤー
 
クラウドレイヤーは、フローマップを使ってアニメーション化できる 2D テクスチャ
です。ベクトルのディスプレイスメントが、赤色と緑色のチャンネルを使用して制御
されます。再生モードで空にわずかな動きを加えることで、背景をより動的にするこ
とができます。クラウドレイヤーは空の手前に配置され、オプションで地面に影を付
けることができます。

 
ローカルまたはグローバルボリュームで、「Visual Environment」の「Background 
clouds」を有効にし、「Cloud Layer」オーバーライドを追加します。

クラウドレイヤーが HDRI Sky の前面に表示されます。

「Visual Environment」でクラウドレイヤーを有効にする

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Cloud-Layer.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Volumetric-Clouds.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Cloud-Layer.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Cloud-Layer.html#controlling-cloud-movement?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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クラウドマップ自体は、円柱投影を使用したテクスチャで、RGBA チャンネルにはそ
れぞれ異なる雲のテクスチャ（積雲、層雲、巻雲、薄雲）が含まれています。そのう
えで、クラウドレイヤーコントロールで各チャンネルをブレンドし、好みの雲形状を
作り上げることができます。4 つのチャンネルを持つ 2 つのレイヤーで、最大 8 つ
の雲景のシミュレーションとブレンドを行うことができます。

クラウドレイヤーのオーバーライド

DefaultCloudMap の 4 つのチャンネル

https://unity.com/ja/
https://en.wikipedia.org/wiki/Equirectangular_projection
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ボリュメトリッククラウドは、メインのディレクショナルライトに反応できます。

雲のアニメーション、ライティング、色、影などを修正しながら、好みの空の景色に
仕上げましょう。
 
ボリュメトリッククラウド
 
雲と光を相互に作用させる必要がある場合は、ボリュメトリッククラウドを使用しま
す。影をレンダリングしたり、フォグを活用したり、ボリュメトリックライトシャフ
トを作成したりすることができます。これらをクラウドレイヤーの雲と組み合わせた
り、別々に追加したりします。
 
ボリュメトリッククラウドを有効にするには、以下のようにします。

— HDRP Asset で、「Lighting > Volumetric Clouds > Volumetric Clouds」を
有効にします。

— ローカルボリュームまたはグローバルボリュームで、「Volumetric Clouds」
オーバーライドを追加します。

https://unity.com/ja/
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各種の雲のマップは、「Advanced」と「Manual」の「Cloud Control」オプション
で定義できます。

クラウドレイヤーとボリュメトリッククラウドのオーバーライドについては、HDRP 
のクラウドに関するドキュメントを参照してください。ボリュメトリッククラウドの
詳細については、「Unity 2021.2 の新しいライティング機能」を参照してください。

「Volumetric Clouds」のオーバーライド

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Cloud-Layer.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Volumetric-Clouds.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/clouds-in-hdrp.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/clouds-in-hdrp.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://resources.unity.com/games/new-lighting-features-in-unity-2021-2-volumetric-clouds?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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シャドウ
暗闇がなければ光を認識することはできません。シーン内に適切に配置されたシャド
ウは、ライティングそのものと同じくらい趣を生み出し、シーンに奥行きや立体感を
加えることができます。HDRP には、シャドウを微調整し、レンダリングが単調にな
るのを防ぐための機能が多数あります。

シャドウマップ

シャドウは、シャドウマッピングという手法でレンダリングされます。この手法では、
ライトの視点からの深度の情報がテクスチャーに保管されます。

「Light」コンポーネントの「Shadows」サブセクションで、シャドウマッピングの
「Update Mode」と「Resolution」を変更できます。解像度と更新頻度の設定値が
高くなるほど、リソースの消費が大きくなります。

シャドウカスケード

ディレクショナルライトの場合は、シャドウマップがシーンの大部分を覆うため、透
視エイリアシングと呼ばれる問題が生じることがあります。カメラから近い位置にあ
るシャドウマップのピクセルは、遠くにあるものよりも、ギザギザで粗くなります。

ライトごとのシャドウ設定

透視エイリアシングと粗いシャドウ シャドウカスケードによって透視エイリアシングが低減されます

https://unity.com/ja/
https://en.wikipedia.org/wiki/Shadow_mapping
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Unity では、カスケードシャドウマップを使用してこの問題を解決しています。この
手法では、カメラの錐台を、それぞれにシャドウマップがある複数のゾーンに分割し
ます。これにより、透視エイリアシングのエフェクトが低減されます。

シャドウカスケードでは、カメラの錐台を複数のゾーンに分割しま
す。各ゾーンにそれぞれシャドウマップがあります。

「Shadows」のオーバーライド

HDRP では、「Shadows」のオーバーライドで、シャドウカスケードをより詳細に制
御できます。ボリュームごとのカスケード設定を使用して、それぞれのカスケードの
始点と終点を微調整できます。

https://unity.com/ja/
https://docs.unity3d.com/Manual/shadow-cascades.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Shadows.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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「Show Cascades」ボタンを切り替えて、カスケードの分割をより簡単に可視化で
きます。ある程度の調整を加えることで、透視エイリアシングを最小限に抑えること
ができます。

コンタクトシャドウ

シャドウマップは、特に 2 つのメッシュサーフェスが結合する目立ちやすいエッジ
で、小さなディテールを取り込めないことがよくあります。HDRP では、「Contact 
Shadows」のオーバーライドを使用して、こうしたコンタクトシャドウを生成でき
ます。

コンタクトシャドウはスクリーンスペースエフェクトの一種で、フレーム内の情報を
基に計算を行います。フレーム外のオブジェクトは、コンタクトシャドウには影響し
ません。コンタクトシャドウは、画面上のフットプリントが小さいシャドウのディテー
ルに使用します。

「Frame Settings」で「Contact Shadows」を有効にします。「Lighting Quality 
Settings」の「Pipeline Asset」で、「Sample Count」を調整することもできます。

「Show Cascades」をクリックすると、カスケードの分割を可視化できます。

「Contact Shadows」のオーバーライド

https://unity.com/ja/
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「Micro Shadows」のオーバーライド

マイクロシャドウによって、植え込みのコントラストが強められています。

コンタクトシャドウ

シャドウの厚み、品質、フェードの設定を調整します。

この機能は、2021 LTS 以降のバージョンで、Terrain（地形）や SpeedTree との連
携が改善されました。ブログで詳細をご覧いただけます。

 
Micro Shadows

HDRP では、小さなシャドウのディテールをマテリアルに広げることができます。
「Micro Shadows」は、法線マップとアンビエントオクルージョンマップを使用して、
メッシュのジオメトリそのものを使用せずに、非常に細かいサーフェスのシャドウを
レンダリングします。

「Micro Shadows」のオーバーライドをシーン内のボリュームに追加し、「Opacity」
を調整します。「Micro Shadows」を利用できるのはディレクショナルライトのみ
です。

https://unity.com/ja/
https://blog.unity.com/games/experience-the-new-unity-terrain-demo-scenes-for-hdrp-and-urp?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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リフレクション
リフレクションは、ゲームオブジェクトと周囲の環境を統合するのに役立ちます。通
常、リフレクションは、滑らかで光沢のあるサーフェスに関連付けますが、滑らかで
はないマテリアルの場合でも、PBR ワークフローで適切なリフレクションを受ける
必要があります。HDRP では、次のようなさまざまな手法でリフレクションを生成で
きます。

— スクリーンスペースリフレクション

— リフレクションプローブ

— スカイリフレクション

各リフレクションタイプは、リソースの消費が大きくなる場合があるため、ユースケー
スに合わせて最適な手法を選択してください。複数のリフレクション手法がピクセル
に適用される場合、各リフレクションタイプの効果がブレンドされます。「Influence 
Volume」という名前のバウンディングサーフェスを使用して 3D スペースを分割し、
リフレクションを受け取るオブジェクトを指定してください。

スクリーンスペースリフレクション

スクリーンスペースリフレクションでは、深度とカラーバッファーを使用してリフレ
クションを計算します。そのため、反射するのはカメラビューに入っているオブジェ
クトのみになり、画面上の位置によっては適切にレンダリングされない場合がありま
す。光沢のある床や濡れた平面サーフェスが、スクリーンスペースリフレクションを
受け取る対象として適しています。

スクリーンスペースリフレクションでは、フレーム外のオブジェクトはすべて無視さ
れるため、それがエフェクトの制限となる場合があります。

「Influence Volume」では、リフレクションプローブによってリフレクションを生成する場所を指定します。

https://unity.com/ja/


68/100 | unity.com© 2021 Unity Technologies

「Lighting」の「Frame Settings」（「HDRP Default Settings」またはカメラの「Custom 
Frame Settings」）で、「Screen Space Reflection」が有効になっていることを確
認してください。続いて、「Screen Space Reflection」のオーバーライドをボリュー
ムオブジェクトに追加します。

スクリーンスペースリフレクションを表示するには、マテリアルのサーフェス
を「Minimum Smoothness」の値以上にする必要があります。比較的粗いマテ
リアルに SSR を適用したい場合は、この値を引き下げます。ただし、「Minimum 
Smoothness」のしきい値を下げると、計算コストが大きくなる場合があります。
スクリーンスペースリフレクションの効果をピクセルに適用できなかった場合は、
HDRP はリフレクションプローブを使用する方法にフォールバックします。

「Quality」ドロップダウンを使用して、既定数の「Max Ray Steps」を選択します。「Max 
Ray Steps」が多くなると、クオリティーは上がりますが、コストは大きくなります。
すべてのエフェクトと同様、パフォーマンスとビジュアルクオリティーのバランスを
とることが大事です。

注：HDRP バージョン 12 以降では、アキュムレーションを用いた物理ベースのアル
ゴリズム（新）と、それより精度の低い近似アルゴリズム（デフォルト）のいずれか
を選択することができます。

「Screen Space Reflection」のオーバーライド

スクリーンスペースリフレクション

https://unity.com/ja/
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リフレクションプローブ

リフレクションプローブを使用すると、画像ベースの手法でリフレクションが生成さ
れます。プローブは、周囲全方向の球面ビューを取り込み、その結果をキューブマッ
プのテクスチャーに保管します。シェーダーは、そのキューブマップを使用してリフ
レクションを再現します。

各シーンに複数のプローブを適用し、結果をブレンドできます。以降、ローカライズ
されたリフレクションが環境内のカメラの動きに合わせて変化します。

各プローブの「Type」を「Baked」または「Real-time」に設定します。

— 「Baked」のプローブは、静的環境でキューブマップのテクスチャーを 1 回だ
け処理します。

— 「Real-time」プローブは、ランタイム時にエディターではなくプレイヤー内に
キューブマップを作成します。そのためリフレクションが静的オブジェクトに
限定されなくなりますが、リアルタイム更新によってリソース消費が大きくな
る場合があることに注意してください。

 
 
 
 
 
 
 
 
 
 

最適化のヒント

リアルタイムリフレクションプローブを最適化するには、全般的なカメラ設定または
リフレクションプローブごとのカメラ設定をオーバーライドして、リフレクションの
ビジュアルクオリティーに大きく寄与しないレンダリング機能をすべて無効にしま
す。また、スクリプトを作成して更新をタイムスライスすることもできます。

「Reflection Probe」コンポーネント

https://unity.com/ja/
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「Influence Volume」によって、ゲームオブジェクトがリフレクションを受け取る 
3D の境界を指定します。一方「Capture Settings」では、リフレクションプロー
ブによってキューブマップのスナップショットを取得する方法をカスタマイズでき
ます。
 
平面リフレクションプローブ

平面リフレクションプローブでは、サーフェスのスムースネスを考慮して、反射する
平面サーフェスを再現できます。鏡や光沢のある床を表現するのには最適です。

平面リフレクションプローブは、通常のリフレクションプローブとの共通点が多数
ありますが、処理が若干異なります。環境をキューブマップとして取り込むのでは
なく、プローブの鏡面で反射されたカメラのビューを再現します。

その後、生成された反射像が 2D RenderTexture として保存されます。この画像が矩
形のプローブの境界に描画され、平面リフレクションを生み出します。

平面リフレクションプローブでは、平面にカメラを反射させることで、鏡面画像を取り込みます。

3 種類のマテリアルに適用された平面リフレクションプローブ

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Planar-Reflection-Probe.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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スカイリフレクション

近傍のリフレクションプローブの影響を受けないオブジェクトは、スカイリフレク
ションにフォールバックします。

リフレクション階層

HDRP では質の高いリフレクションが得られるよう、各ピクセルの精度を最大限に高
め、他の手法とブレンドすることができる手法を使用しています。HDRP では、加重
優先度を基に、3 つのリフレクション方法（SSR、リフレクションプローブ、空）を
チェックします。リフレクションを評価する際のこのシーケンスは、リフレクション
階層と呼ばれます。

1 つのピクセルで、ある手法によってリフレクションを特定できなかった場合は、そ
の次の手法にフォールバックします。つまり、スクリーンスペースリフレクションは
リフレクションプローブにフォールバックし、その後スカイリフレクションにフォー
ルバックします。

「Reflection Probe」プロパティーで、「Influence Volume」を設定することが大事で
す。これを設定しないと、不適切なスカイリフレクションからライトが漏れる場合が
あります。

これは、SampleScene の Room 3 で顕著です。いずれかの「Reflection Probe」を
無効にするか、「Influence Volume」を変更すると、リフレクションが強制的に空に
フォールバックされます。これにより、HDRI の明るい空が、強力なリフレクション
によってシーンよりも過剰に強調されます。

リフレクション階層の確認の詳細については、ドキュメントの HDRP のリフレク
ションに関するページをご覧ください。

リフレクションプローブは周囲の部屋を映し、スカイリフレクションはグラデーションのある空を映します。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Reflection-in-HDRP.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Reflection-in-HDRP.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Reflection-in-HDRP.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Reflection-in-HDRP.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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リフレクションプロキシボリューム

リフレクションプローブのキャプチャポイントは固定されており、リフレクションプ
ローブの近くのカメラ位置と一致することはほとんどないため、生成されたリフレク
ションで、透視のシフトが目立つ場合があります。それにより、リフレクションが環
境になじんでいないように見える場合があります。

リフレクションプロキシボリュームは、これを部分的に修正するのに役立ちます。カ
メラ位置を基に、プロキシボリューム内でより正確にリフレクションを再投影します。

Room 3 の天井でリフレクションプローブを無効にすると、不要なライトの漏れが生じます。

リフレクションプロキシボリュームでは、部屋のワールド空間の位置に合わせてキューブマップを再投影します。

https://unity.com/ja/
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リアルタイムライティン
グエフェクト
HDRP は、ボリュームシステムを通じて、いくつかのリアルタイムライティングエフェ
クトを利用することもできます。ローカルまたはグローバルボリュームを選択してか
ら、「Add Override > Lighting」で適切なエフェクトを追加します。

Screen Space Ambient Occlusion

アンビエントオクルージョンでは、近接した溝や穴、サーフェスの影のシミュレー
ションを行います。アンビエントライトが遮断されるエリアは、陰影が付いている
ように見えます。

「Ambient Occlusion」のオーバーライド

「Auto Showroom」プロジェクトでのアンビエントオクルージョンの可視化

https://unity.com/ja/
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Unity のライトマッパーを使用して静的ジオメトリのアンビエントオクルージョン
をベイクできますが、HDRP によって、リアルタイム処理を行う Screen Space 
Ambient Occlusion を追加で利用できます。これはスクリーンスペースエフェクト
なので、フレーム内の情報のみが生成されるエフェクトに影響します。SSAO では、
カメラの有効視野外のオブジェクトはすべて無視されます。

「Lighting」の「Frame Settings」で、「Screen Space Ambient Occlusion」を有
効にします。続いて、ローカルまたはグローバルボリュームで「Add Override」を
クリックし、「Lighting > Ambient Occlusion」を選択します。

スクリーンスペースグローバルイルミネーション

スクリーンスペースグローバルイルミネーション（SSGI）では、画面の深度とカラー
バッファーを使用して、反射するディフューズライトを計算します。ライトマッピン
グで間接光を静的レベルのジオメトリのサーフェスにベイクする方法と似ています
が、SSGI では光子がサーフェスに衝突して反射する際に色やシェーディングが変化
する仕組みのシミュレーションをさらに正確に行うことができます。

このサンプルシーンの Room 2 では、SSGI を有効にすることで、揺れる木の葉の緑
が反射光として壁面に映っていることがわかります。

「Screen Space Global Illumination」のオーバーライド

スクリーンスペースグローバルイルミネーションによって、植物の葉の反射光をリアルタイムで描画しています。

https://unity.com/ja/
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カメラの有効視野外のオブジェクトはグローバルイルミネーションには影響しない
ため、フレームバッファに依存する他のエフェクトと同様、画面端が問題になりま
す。このジレンマは、フレームバッファの外でレイマーチングを行う際にフォール
バックを提供するリフレクションプローブを使用することで部分的に改善すること
があります。

SSGI は、「Lighting」の「Frame Settings」で有効にします。パイプラインアセッ
トの「Lighting」セクションでも有効にする必要があります。

注：スクリーンスペースグローバルイルミネーションを含む Unity 2021.2 以降を使
用することをおすすめします。HDRP 12 では、SSGI のクオリティーが大幅に改善さ
れています。

Screen Space Refraction

「Screen Space Refraction」オーバーライドは、大気よりも密度が高いメディア
を通過する光の動きのシミュレーションを行う際に役立ちます。HDRP の Screen 
Space Refraction では、深度とカラーバッファを使用して、ガラスなどの透明なマ
テリアルを透過する光の屈折を計算できます。

HDRP/Lit シ ェ ー
ダーでこのエフェ
クトを有効にする
には、マテリアル
の「Surface Type」
が「Transparent」
になっていること
を確認します。

続いて、
「Transparency 
Inputs」で
「Refraction Model」と「Index of Refraction」を選択します。中空でないオブジェク
トの場合、「Refraction Model」には「Sphere」を使用します。中空のオブジェクトに
ついては「Thin」（泡など）または「Box」（わずかに厚みがあるもの）を選択します。

「Screen Space Refraction」のオーバーライド

屈折を制御する「Transparency Inputs」

Screen Space Refraction

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Refraction-in-HDRP.html#ScreenSpaceRefraction?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Refraction-in-HDRP.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://en.wikipedia.org/wiki/Refractive_index
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ポストプロセス
最新のハイエンドグラフィックスにおいては、ポストプロセスを行わずして完成する
ことはないとも言えます。必ずしもプロセッシングで問題を修正できるわけではあり
ませんが、シネマティックな効果を高めるフィルターやフルスクリーンのイメージエ
フェクトを使用せずに画像をレンダリングすることは、ほとんど考えられません。そ
のため、HDRP には組み込みのポストプロセスエフェクトがバンドルされています。

HDRP のプロセッシングでは、ボリュームシステムを使用してイメージエフェクトを
カメラに適用します。オーバーライドを追加する方法を理解すれば、ポストエフェク
トを適用するプロセスも理解しやすくなるはずです。

ポストプロセスエフェクトを使用すると、よりシネマティックなレンダリングが可能になります。

https://unity.com/ja/
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「Post-processing（ポストプロセス）」でのオーバーライド

色やコントラストを制御するこうした「Post-processing」のオーバーライドの多く
は、機能が重複しています。適切な組み合わせを見つけるためには、ある程度の試行
錯誤が必要です。

すべてのエフェクトを利用する必要はありません。目標とするビジュアルを生み出す
ために必要なオーバーライドのみを追加し、その他は無視します。

使用例については、SampleScene のボリュームをご覧ください。

 

トーンマッピング

トーンマッピングとは、ハイダイナミックレンジの色を、使用する画面の狭いダイナ
ミックレンジにマッピングする手法です。レンダリングでのコントラストやディテー
ルを改善できます。

「Post-processing（ポストプロセス）」のオーバーライド

「ACES」と「Neutral」のトーンマッピングの比較

https://unity.com/ja/
https://en.wikipedia.org/wiki/High-dynamic-range_imaging
https://en.wikipedia.org/wiki/Dynamic_range
https://en.wikipedia.org/wiki/Dynamic_range
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ビジュアルをフィルム調にしたい場合は、「Mode」を業界標準の「ACES」（Academy 
Color Encoding System）に設定します。彩度やコントラストを落とす場合は、
「Neutral」を選択します。経験豊富なユーザーであれば、「Custom」を選択し、トー
ンマッピング曲線を自分で定義することもできます。

Shadows、Midtones、Highlights

「Shadows、Midtones、Highlights」のオーバーライドでは、レンダリング対象のシャ
ドウ、中間調、ハイライトそれぞれの色調と色の範囲を制御できます。それぞれのト
ラックボールを使用して、画像内のそれぞれの特性を調整できます。その後、色補正
をクリップまたはプッシュしすぎないように、「Shadow」と「Highlight Limits」を
使用します。

カスタム曲線を使用したトーンマッピング

Shadows, Midtones, Highlights

https://unity.com/ja/
https://en.wikipedia.org/wiki/Academy_Color_Encoding_System
https://en.wikipedia.org/wiki/Academy_Color_Encoding_System
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Bloom

「Bloom」では、光源の周囲に発生する光のにじみのエフェクトを生成できます。こ
れにより、強烈に輝く、まばゆい光の印象を生み出すことができます。
 

「Intensity」と「Scatter」を設定することで、ブルームのサイズと明度を調整します。
「Lens Dirt」は、ブルームエフェクトを散乱させる汚れやちりのテクスチャを適用し
ます。明度の低いピクセルでシャープネスを維持するには、「Threshold」を使用し
ます。

「Bloom」のオーバーライド

ブルームのエフェクト

https://unity.com/ja/
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Depth of Field

「Depth of Field」は、実際のカメラレンズの集束特性のシミュレーションを行います。
カメラの焦点距離より近い、または遠いオブジェクトは、ぼやけて見えます。

焦点距離は、以下の場所から設定できます。

— 「Manual Ranges」フォーカスモードを使用した Volume オーバーライド：焦
点距離は、Volume 自体によって制御されます。例えば、水中のシーンなど、
場所によって意図的にカメラをぼやけさせるといった使い方ができます。

— 「Volume Settings Extension」での Cinemachine カメラの使用：ターゲット
を追従してオートフォーカスすることができます。

— 「Physical Camera」フォーカスモードを使用した「Physical Camera」プロ
パティ：Camera コンポーネントの「Focus Distance」パラメーターをアニメー
ション化できます。

「Depth of Field」が有効な場合は、ボケと呼ばれるフォーカス外のぼかしエフェク
トが、画像の明るいエリアを中心に現れます。カメラの開口形状を調整し、ボケの見
え方を変えることができます（前述の「Physical Camera」のその他のパラメーター
を参照）。

「Depth of Field」のオーバーライド

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.cinemachine@2.8/manual/CinemachineVolumeSettings.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://en.wikipedia.org/wiki/Bokeh
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シネマティクスやオフラインレンダリングでは、追加の設定とカスタム品質を有効に
することで、負荷は増しますが「Physically Based」の被写界深度を試すことができ
ます。

「Depth of Field」では、実際のカメラの被写界深度のシミュレーションを行います。

「Depth of Field」では、実際のカメラの被写界深度のシミュレーションを行います。

White Balance

「White Balance」のオーバーライドを使用すると、最終的な画像で白色が適切にレ
ンダリングされるようにシーンの色を調整できます。「Temperature」で、黄色（暖
色）と青（寒色）の間を調整することもできます。「Tint」では、緑とマゼンタの間
で色かぶりを調整します。

https://unity.com/ja/
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この HDRP サンプルプロジェクトでは、各部屋のローカルボリュームに「White 
Balance」のオーバーライドが含まれています。

Color Curves

グレーディングカーブを使用して、色相、彩度、明るさの特定の範囲を調整できます。
8 つのグラフのいずれかを選択し、色とコントラストをリマップします。

Color Adjustments

このエフェクトを使用して、最終的にレンダリングされる画像の全体的なトーン、明
度、色相、コントラストを調整します。

White Balance

Color Curves

Color Adjustments

https://unity.com/ja/
https://en.wikipedia.org/wiki/Curve_(tonality)
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Channel Mixer

「Channel Mixer」では、カラーチャンネルの「組み合わせ」に、さらに別のカラーチャ
ンネルを適用できます。RGB 出力を選択してから、いずれかの入力の影響度を調整
します。たとえば、「Red Output Channel」で「Green」の影響度を上げると、画像
内のすべての緑色の部分が赤みがかって表示されます。

Lens Distortion

「Lens Distortion」では、現実世界のレンズの製造過程で発生する歪みによって生じ
る放射パターンのシミュレーションを行います。これを設定すると、特にズームレン
ズや広角レンズを使用したときに、直線がわずかに曲がって見えます。

Channel Mixer

「Lens Distortion」を使用すると、放射パターンの歪みを画像に適用します。

https://unity.com/ja/
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Vignette

「Vignette」では現実世界の写真に生じる効果を再現し、画像の端部の明度や彩度を
下げます。この現象は、広角レンズを使用した場合や、レンズフードや重ね付けした
フィルターリングによって光が遮られた場合に発生することがあります。見る人の視
線を画面中央に集めるために、このエフェクトが使用されることもあります。

Motion Blur

現実世界では、カメラの露出時間よりも速く移動する物体を撮影すると、線状になっ
たりぼやけたりした状態で写ります。「Motion Blur」のオーバーライドで、このよう
な効果のシミュレーションを行うことができます。

パフォーマンスコストを最小限に抑えるためには、「Sample Count」を減らし
て「Minimum Velocity」を上げ、「Maximum Velocity」を下げます。「Additional 
Properties」で「Camera Clamp Mode」のパラメーターを下げることもできます。

「Vignette」を使用すると、フレームの端部が暗くなります。

https://unity.com/ja/
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レンズフレア
レンズフレアとは、カメラのレンズに明るい光が当たったときに発生するアーティ
ファクトです。レンズフレアは、1 つの明るいグレアとして現れる場合と、カメラの
開口形状に沿った多数の色付き多角形のフレアとして現れる場合とがあります。現実
の世界ではフレアは好ましくない効果をもたらしますが、物語や芸術の目的では有益
な働きをする場合もあります。例えば、強いレンズフレアを使用することで、プレイ
ヤーの注意を引いたり、設定やシーンの雰囲気を変えたりすることができます。レン
ズフレアは、レンダリングプロセスの後段で描画されるため、基本的にはポストプロ
セスエフェクトです。
 
フレアの外観はフレアアセットで指定されますが、そのエフェクトをレンダリングす
るためには、シーンビューで Lens Flare (SRP) コンポーネントをオブジェクトに追
加する必要があります。例えば、フレアを発生させる物体や光源などです。エフェク
トの一般的なパラメーターである強度、スケール、オクルージョンは、このコンポー
ネントによって制御されます。また、フレアがカメラビューの外にあるときに画面外
で実行することもできますが、その場合でも、フレアが静的な光源から来るときなど、
一部のフレアエフェクトはシーンに投影されます。
 
レンズフレアを使いこなすには、Package Manager からサンプルをインストールす
るのが一番です。そうすることで、事前に定義された一連のフレアアセットが追加
され、レンズフレアエフェクトを含むように HDRP サンプルシーンが変更されます。
また、レンズフレアを閲覧できるテストシーンも収録されているので、独自に作成す
る際の参考になります。

実際の写真からのレンズフレア。レンズフレアの物理的な特徴については、Wikipedia の記事に詳しく説明されています。

レンズフレアのサンプルは、Package Manager の「High Definition RP」にあります。

https://unity.com/ja/
https://docs.unity3d.com/Manual/class-Flare.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/lens-flare-data-driven-component.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://en.wikipedia.org/wiki/Lens_flare


86/100 | unity.com© 2021 Unity Technologies

 
プロジェクトの「Directional Light Sun」を選択すると、ライトにアタッチされた 
Lens Flare (SRP) コンポーネントと、Lens Flare データアセットを確認できます。
アセットを変更すると、さまざまなフレアエフェクトを観察することができます。

 

レンズフレアはレンズフレア要素で作られており、各要素はフレアが生み出すさまざ
まなアーティファクトを表しています。要素の形状には、ポリゴン、円、カスタム画
像などがあります。
 
要素のパラメーターで、色、
トランスフォームの位置、デ
フォーメーションのほか、複数
の要素を含んだレンズフレアエ
フェクトの一部である場合のフ
レア要素の配置、色、スケール
を微調整することが可能です。
フレア要素を光源にアタッチす
れば色合いが使用できるので、
同じフレアアセットをさまざま
な光源で再利用することができ
ます。
 
レンズフレアのしくみについて
詳しくは、こちらのプレゼン
テーションをご覧ください。

フレアアセットとその要素および使用可能なパ
ラメーター。カスタムフレアエフェクトの独自
のライブラリを作成して、ゲームに適した雰囲
気を作り出すこともできます。

レンズフレアのサンプルには、リアルなレンズエフェクトや架空のレンズエフェクトなどのさまざまなプリセットが用意されています。

https://unity.com/ja/
https://youtu.be/p48rNiJBFG0?t=892?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://youtu.be/p48rNiJBFG0?t=892?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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動的解像度
CPU がボトルネックにならない場合、性能に大きく影響する可能性があるのは解像
度です。動的解像度は、レンダリング解像度を下げ、出力画面の解像度に合わせて
結果をスケールするものです。このアップスケールを行うためのフィルターが 2021 
LTS で大幅に改良され、70% 以下の解像度でレンダリングしても、ほとんどビジュ
アルを損なわないようになりました。

Unity 2021 LTS の HDRP には、最新のスーパーサンプリング技術のいくつかを使用
した複数の選択肢が用意されています。

NVIDIA DLSS（NVIDIA RTX GPU および Windows 向け）

Unity 2021 LTS の HDRP では、NVIDIA DLSS（ディープラーニングスーパーサンプ
リング）がネイティブにサポートされます。NVIDIA DLSS は高度な AI レンダリング
を使用しており、ほんのわずかなピクセルを従来のようにレンダリングするだけで、
ネイティブ解像度に匹敵する画質を実現できます。

リアルタイムレイトレーシングと NVIDIA DLSS により、より高いフレームレートと
解像度で動作する美しい世界を NVIDIA RTX GPU 上で作成することができます。ま
た、DLSS は従来のラスタライズされたグラフィックスに対しても、大幅な性能向上
を実現しています。詳細については、NVIDIA の Unity 開発者ページ、ブログ記事、
ドキュメントを参照してください。

AMD FSR（クロスプラットフォーム）

Unity 2021 LTS では、AMD FidelityFX™ Super Resolution が利用できるようになり
ました。HDRP および URP 用の FSR がビルトインでサポートされます。HDRP ア
セットとカメラで動的解像度を有効にし、アップスケールフィルターオプションから
「FidelityFX Super Resolution 1.0」を選択すると FSR を使用できます。

24 Entertainment の『Nakara Bladepoint』などのゲームを 4K で動作させる DLSS 技術の内部的なしくみについて詳しくは、 
こちらのブログをご覧ください。

https://unity.com/ja/
https://developer.nvidia.com/game-engines/unity-engine
https://developer.nvidia.com/blog/nvidia-dlss-natively-supported-in-unity-2021-2/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.1/manual/deep-learning-super-sampling-in-hdrp.html
https://blog.unity.com/ja/games/the-impact-of-dlss-naraka-bladepoint
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AMD FidelityFX Super Resolution（FSR）は、低解像度の入力から高解像度のフレー
ムを生成するためのオープンソースの高品質ソリューションです。特に高品質のエッ
ジを作成することに重点を置いた最先端のアルゴリズム群が使用されており、ネイ
ティブ解像度で直接レンダリングする場合と比較して大幅な性能向上が得られます。
FSR は、ハードウェアレイトレーシングのようなコストのかかるレンダリング処理に
対して「実用的なパフォーマンス」を実現します。詳細については、AMD の Unity ウェ
ブページおよびフォーラムを参照してください。

 
TAA Upscale（クロスプラットフォーム）

Temporal Anti-Aliasing (TAA) Upscale は、時間積分を用いてシャープな画像を生成
する手法です。Unity では、通常のアンチエイリアシングと並行してこの手法が使用
されます。HDRP は、このアップスケールフィルターをポストプロセスの前に、TAA 
ステップと同時に実行します。つまり、使用できるのは、TAA アンチエイリアシン
グ手法のみということです。このフィルターは、他のアンチエイリアシング手法とは
互換性がありません。Temporal Anti-Aliasing (TAA) Upscale はフレームごとにアン
チエイリアシングを実行します。つまり、動的解像度を有効にすると、スクリーンパー
センテージの解像度の比率が 100% であってもアンチエイリアシングが実行されま
す。詳細については、TAA Upscale についての注意事項に関するドキュメントセク
ションを参照してください。

Steam で配信中の Spaceship デモで FSR のテクノロジーをお試しください。

https://unity.com/ja/
https://gpuopen.com/unity/
https://gpuopen.com/unity/
https://forum.unity.com/threads/amd-fidelityfx-super-resolution-fsr-preview-now-available.1141495/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.1/manual/Dynamic-Resolution.html
https://store.steampowered.com/app/1605230/Spaceship__Visual_Effect_Graph_Demo/
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HDRP Asset で強制的にスケールするか、ロジックをコーディングして動的にスケー
ルを調整することができます。

プロジェクトで動的解像度を設定し、ニーズに合った最適なアルゴリズムを選択する
方法についてのガイダンスを得るには、ドキュメントのこちらのページを参照してく
ださい。

Rendering Debugger
「Rendering Debugger」ウィンドウ（「Window > Analysis > Rendering Debugger」）
には、スクリプタブルレンダーパイプライン用のデバッグツールと可視化ツールがあ
ります。左側はカテゴリ別に分類されています。各パネルでは、ライティング、マテ
リアル、ボリューム、カメラなどの問題を分割できます。

Rendering Debugger

Temporal Anti-Aliasing Upscale 法を用いた左の画像（A）は、シャープで輪郭がはっきりしています。右の画像（B）は、
Catmull-Rom アップスケール法を用いたもので、あまり鮮明に見えません。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/HDRP-Asset.html#DynamicResolution?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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Rendering Debugger は、ゲームビューの再生モードで実行時に利用できるほか、開
発ビルドで作成された Player で利用することもできます。Ctrl + Backspace キーを
使用するか、ゲームコントローラーの 2 本のスティックを押すと、そのメニューを
開くことができます。

このデバッガーは、特定のレンダリングパスのトラブルシューティングに役立ちます。
「Lighting」パネルで「Fullscreen Debug Mode」と入力し、デバッグ機能を選択で
きます。

デバッグモードでは、さまざまな情報を手掛かりにして、ライティングやシェーディ
ングの問題の原因を具体的に突き止めることができます。左側のパネルには、カメラ、
マテリアル、ボリュームなどの重要な統計情報が表示されており、レンダリングの最
適化に役立てることができます。

ゲームビューまたは Player における「Rendering Debugger」ウィンドウ

「Fullscreen Debug Mode」オプション

https://unity.com/ja/
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フルスクリーンのデバッグモードが有効な場合、シーンビューとゲームビューが切り
替わり、特定の機能が一時的に可視化されます。この機能を利用して、効率的に診断
を進めることができます。

一般的なマテリアルプロパティーのデバッグを行うこともできます。「Material」ス
クリーンで、「Common Material Properties」の中から、「Albedo」、「Normal」、
「Smoothness」、「Specular」などを選択します。

「Lighting Debug Mode」と「Fullscreen Debug Mode」は、シーン内の光源を把握するのに有効です。

Common Material Properties（マテリアルの基本プロパティ）

https://unity.com/ja/
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パフォーマンスをデバッグするには、再生モード時に「Rendering Debugger」ウィ
ンドウの統計パネルにアクセスします。

詳細については、レンダーパイプラインデバッガーに関するドキュメントをご覧くだ
さい。

レンダーパイプラインデバッガーを使用すると、マテリアルのトラブルシューティングを行えます。

再生モードの「Rendering Debugger」のパフォーマンス統計

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Render-Pipeline-Debug-Window.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Render-Pipeline-Debug-Window.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook


93/100 | unity.com© 2021 Unity Technologies

レイトレーシング 
（プレビュー）

レイトレーシングは、従来のラスタライゼーションよりも訴求力のあるレンダリング
を生成できる手法です。従来は計算コストが大きい処理でしたが、近年のハードウェ
アアクセラレーションによるレイ交差（トレーシング）の発達により、レイトレーシ
ングのリアルタイム利用が可能になりました。

HDRP におけるレイトレーシングは、フォールバックとして依然としてラスタライズ
レンダリングに依存するハイブリッドシステムであり、一部の GPU ハードウェアと 
DirectX 12 API のサブセットによるレイトレーシングのプレビューサポートを含んで
います。システム要件の一覧については、「Getting started with ray tracing」（英語）
を参照してください。

設定

レイトレーシング（プレビュー版）を有効にするためには、HDRP プロジェクトのデ
フォルトのグラフィックス API を DirectX 12 に変更する必要があります。

「Render Pipeline Wizard」（「Window > Render Pipeline > HD Render Pipeline 
Wizard」）を開きます。「HDRP + DXR」タブで「Fix All」をクリックすると、エディ
ターを再起動するように求められます。

2 Unity 2021 では、「HDRP Wizard」は「Window > Rendering > HDRP Wizard」にあります

「Render Pipeline Wizard」でレイトレーシングを有効にします。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Ray-Tracing-Getting-Started.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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レイトレーシングを手動で設定することもできます。

プロジェクトでレイトレーシングを有効にしたら、「HDRP Global」または「Camera 
Frame Settings」でもレイトレーシングが有効になっていることを確認します。
「Build Settings」で、互換性のある 64 ビットアーキテクチャーを使用しているこ
とを確認します。また、「Edit > Rendering > Check Scene Content for HDRP Ray 
Tracing」から、シーンのオブジェクトを検証します。

オーバーライド

レイトレーシングの導入により、新しい Volume オーバーライドがいくつか追加され、
HDRP の既存のオーバーライドが多数強化されています。

— レイトレーシングされたアンビエン
トオクルージョン：スクリーンス
ペースアンビエントオクルージョン
に代わって、レイトレーシングされ
たアンビエントオクルージョンが導
入されます。スクリーンスペースア
ンビエントオクルージョンと異な
り、レイトレーシングアンビエント
オクルージョンでは、画面外のジオ
メトリを使用してオクルージョンを
生成できます。これにより、フレー
ムの端に向かうにつれてエフェクト
が消えたり、不正確になったりする
問題が解消されます。

— ライトクラスター：HDRP によって、
カメラを中心とした軸平行のグリッ
ドにシーンが分割されます。HDRP 
は、この構造体を使用して、光線が
サーフェスに当たったときのライ
ティングに寄与する可能性がある一
連の局所的ライトを判別します。そ
の後、特定のエフェクトの反射光
を計算します（レイトレーシングされたリフレクション、レイトレーシングさ
れたグローバルイルミネーションなど）。考慮すべきゲームオブジェクトとラ
イトを包含するようにこの構造体の範囲を変更するには、「Camera Cluster 
Range Volume Override」を使用します。

 

指示に従って無効になっている機能を修正します。

スクリーンスペースアンビエントオクルージョンとレイト
レーシングされたアンビエントオクルージョン

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Ray-Tracing-Getting-Started.html#ManualSetup?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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「HDRP Debug」モードは、「Windows > Analysis > Rendering Debugger > 
Lighting > Full Screen Debug mode」から利用できます。これによって、赤
でハイライトされたライトクラスターセルを可視化し、ライト数が HDRP ア
セットの「Maximum Lights per Cell」に達した場所を示すことができます。
この設定を調整することで、不要なライトの漏れやアーティファクトを減らす
ことができます。

— レイトレーシングされたグローバルイルミネーション：スクリーンスペースイ
ルミネーションとライトプローブに代わる機能で、間接的な反射光のシミュ
レーションを行います。レイトレーシングされたグローバルイルミネーション
の計算はリアルタイムで実行されます。オフラインでのライトマップのベイキ
ングプロセスに長い時間をかけなくても、同等の結果を実現できます。

 
複数の反射やサンプルからメリットを得られる複雑な屋内環境には、「Quality」
設定を使用します。「Performance」モード（1 つのサンプルと 1 つの反射に
限定）は、ライティングのほとんどがメインのディレクショナルライトによっ
て行われる屋外の状況に適しています。

デバッグモードでのレイトレーシングライトクラスター

レイトレーシングされたグローバルイルミネーションによって、反射光がリアルタイムで表示されます。

https://unity.com/ja/
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— レイトレーシングされたリフレクション：レイトレーシングされたリフレク
ションでは、リフレクションプローブやスクリーンスペースリフレクションよ
りも質の高いリフレクションを再現できます。画面外のメッシュは、生成され
たリフレクションで適切に表示されます。

 
「Minimum Smoothness」と「Smoothness Fade Start」の値を調整すると、
滑らかなサーフェスがレイトレーシングリフレクションを受け始めるしきい値
を変更できます。必要に応じて「Bounces」を増やすこともできますが（合わ
せ鏡のような場合）、パフォーマンスコストに注意してください。

レイトレーシングされたリフレクションが、滑らかな鏡のような面にレンダリングされています。

https://unity.com/ja/
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レイトレーシングされたシャドウはキャスターから離れるにつれてぼやけるため、シャドウマッピングとは異なる効果が得られ
ます。ディレクショナルライト、ポイントライト、スポットライトで、半透明のシャドウを生成することもできます。

レイトレーシングされたシャドウ：ディレクショナル、ポイント、スポット、矩形
エリアの各ライトのレイトレーシングシャドウを、不透明なゲームオブジェクトの
シャドウマップの代わりに使用することができます。ディレクショナルライトを使
用して、透明または半透明のゲームオブジェクトからレイトレーシングされたシャ
ドウを投影することもできます。
 
レイトレーシングでは、キャスターとの距離が離れるほど柔らかくなる、現実のよう
な自然な影を表現することができます。

https://unity.com/ja/
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HD レンダーパイプラインのレイトレーシング機能（プレビュー）のウォークスルー
については、HDRP でのレイトレーシングのアクティベートに関する動画をご覧くだ
さい。詳しくは、HDRP のマイクロサイトでレイトレーシングに関するドキュメント
をご覧ください。A

HDRP のディレクショナルライトで、半透明の色付きシャドウを生成することもでき
ます。この例では、ガラスのサーフェスによって、リアルな色合いのシャドウが床に
キャストされています。

透明のシャドウキャスターには「Transmittance Color」を使用します。

その他のリソース

— HDRP の機能に関する概要動画については、このガイドと合わせて、HDRP で
高品質なグラフィックスを作成する方法をご覧いただくことをおすすめします。

— ビルトインレンダーパイプラインから移行する場合は、こちらのチャートをご
覧ください。両者の機能の違いが詳細にまとめられています。

— HDRP に関するドキュメントには、このパイプラインのあらゆる機能の詳細が
含まれています。

— パフォーマンスを向上させるための HDRP の設定については、こちらのブログ
で詳しく説明しています。

https://unity.com/ja/
https://www.youtube.com/watch?v=ad9f_nKU0ZA
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Ray-Tracing-Getting-Started.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=render-with-quality-and-flexibility&utm_content=the-definitive-guide-to-lighting-in-hdrp-21-lts-ebook
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さらに先へ：
このガイドをきっかけに、皆様が次のプロジェクトで HDRP に取り
組んでいただければ幸いです。

さらに詳しく知りたい方は、「3D Sample Project」を Unity Hub から入手できるの
でご利用ください。このガイドに関して質問やご意見がありましたら、このフォーラ
ムのスレッドでお知らせください。

以下のその他のリソースもぜひご確認ください。また、Unity ブログや HDRP コミュ
ニティフォーラムでは、いつでもヒントを得ることができます。
 
Unity は、リアルタイムコンテンツを作成するための最高のツールを用意して、アー
ティストや開発者の皆様を支援したいと考えています。ライティングは芸術であり、
科学です。芸術と科学を融合させることで、魔法のような効果が生まれます。
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